
  
    
  
3. COPYING IN QUANTITY



If you publish printed copies of the Document numbering more than 100, and the Document’s license notice requires Cover Texts, you must enclose the copies in covers that carry, clearly and legibly, all these Cover Texts: Front-Cover Texts on the front cover, and Back-Cover Texts on the back cover. Both covers must also clearly and legibly identify you as the publisher of these copies. The front cover must present the full title with all words of the title equally prominent and visible. You may add other material on the covers in addition. Copying with changes limited to the covers, as long as they preserve the title of the Document and satisfy these conditions, can be treated as verbatim copying in other respects.
If the required texts for either cover are too voluminous to fit legibly, you should put the first ones listed (as many as fit reasonably) on the actual cover, and continue the rest onto adjacent pages.
If you publish or distribute Opaque copies of the Document numbering more than 100, you must either include a machine-readable Transparent copy along with each Opaque copy, or state in or with each Opaque copy a publicly-accessible computer-network location containing a complete Transparent copy of the Document, free of added material, which the general network-using public has access to download anonymously at no charge using public-standard network protocols. If you use the latter option, you must take reasonably prudent steps, when you begin distribution of Opaque copies in quantity, to ensure that this Transparent copy will remain thus accessible at the stated location until at least one year after the last time you distribute an Opaque copy (directly or through your agents or retailers) of that edition to the public.
It is requested, but not required, that you contact the authors of the Document well before redistributing any large number of copies, to give them a chance to provide you with an updated version of the Document.

Capitolo 8. Resoconti e diagrammi



Nota
This section is a «work in process» all of the material has not been reviewed for V2.0. While it may not be strictly accurate, it is at least a "guide".

Resoconti e diagrammi permettono a GnuCash di presentare una vista generale dei dati finanziari in vari modi. Questi strumenti vanno da un semplice sommario dei totali del conto ad una visualizzazione avanzata di un portafoglio. Questa sezione presenterà una spiegazione dei principali resoconti di GnuCash e su come personalizzarli
GnuCash classifica i resoconti principali in quattro classi; questi sono tutti disponibili nel menu resoconti.
Resoconti generali



The General Reports include the Account Summary Report, Custom Reports, the Tax Schedule Report and TXF Export, and the Transaction Report and also the reports in the Sample & Custom menu.
	Sommario del conto:

	Tax Schedule Report and TXF Export: The tax schedule report lists all taxable income and deductible expense amounts used in the preparation of US Income Tax returns. The purpose of the report is to provide a complete audit trail for these amounts. The report is intended to be used by a tax payer to manually prepare his or her own tax return, or alternatively, to be provided to a tax preparer for that purpose. The report can also be used to generate an export of all tax related income and expenses to a TXF (Tax eXchange Format) file (this is in addition to exporting to the HTML format that all reports allow). The TXF file can be imported into tax filing programs such as TaxCut or TurboTax. The report should be run, inspected carefully for errors or omissions, and then corrections made to transactions, report settings, currency conversion rates or the account structure as needed. This process should be repeated as often as needed until all the amounts on the report are correct before a final version is used and saved along with the tax returns.
 For accounts specified in the report options (none = all) that are also flagged as Tax-related, all transactions for the time period selected (also in the report options) are included. The report sorts transactions by date within account providing subtotals by account within tax code within Form or Schedule line number. Support is also provided for multiple copies of and for sub-line items for selected Forms/Schedules. Optionally uses special date processing to include federal estimated tax payments after year end.
All totals are in USD since this is the currency required for filing US Income Tax returns. Non-USD transaction amounts are converted to USD using the transaction conversion rate to USD, if available. If not, a conversion rate from the price database is used (either the date nearest the transaction date or nearest the report date as specified in the report options; if none is available, transaction amounts are converted to zero and the report provides a comment accordingly). A complete audit trail of conversions is provided.
Nota
For this to work, the user has to segregate taxable and non taxable
           income to different accounts, as well as deductible and non deductible expenses.
           The Income Tax Information dialog is used for this. To access the Income Tax
           Information dialog go to Edit → Tax Report Options. The user
           also must set the TXF category of each tax related account. The Income Tax
           Information dialog is described in the la sezione chiamata «Impostare le opzioni per i resoconti delle tasse» section.


	Resoconto delle transazioni:

	Semplice resoconto di benvenuto:

	Resoconto multicolonna personalizzato: questo resoconto permette di inserire più resoconti in un’unica finestra per esaminare un gruppo di informazioni finanziarie contemporaneamente.

	Grafici semplici

	Resoconto semplice con esempi:





Assistente dall’ultimo avvio



L’assistente Dall’ultimo avvio viene avviato automaticamente quando si esegue GnuCash; permette di inserire nel registro qualsiasi transazione il cui inserimento automatico sta per avvenire. L’esecuzione all’avvio di GnuCash può essere modificata nella finestra delle preferenze di GnuCash all’interno della scheda Transazioni pianificate. Per eseguire l’assistente manualmente, andare in Operazioni → Transazioni pianificate → Dall’ultimo avvio...
Nella finestra Dall’ultimo avvio... sono presenti tre colonne:
	Transazione
	Il nome assegnato nell’Editor transazioni pianificate che identifica la transazione pianificata.

	Stato
	Il valore del campo  State può essere uno tra i seguenti:
Suggerimento
Fare clic nel campo della colonna dello Stato relativa a una transazione per modificarne lo stato (questa opzione è disponibile solamente se il campo dello stato non è vuoto)

	Ignora
	Se viene visualizzata una transazione pianificata, da creare o come promemoria, l’utente può impostare lo stato a Ignorato per scartare l’inserimento. La transazione pianificata non verrà inserita nel registro e la transazione verrò ricordata solamente nell’occorrenza successiva. Per esempio, se è stato impostato un promemoria per una transazione relativa a un trasferimento di 500€ alla fine del mese verso il proprio conto risparmi, e questo mese si è acquistato un nuovo computer a causa del quale non si avrà la disponibilità di quella cifra, si potrà impostare lo stato della transazione a Ignorato.

	Posticipato
	Se una transazione pianificata e identificata come Da creare ma la si vuole trattenere evitando che venga inserita nel registro, si può cambiarne lo stato in Posticipato.

	Promemoria
	Si è a n giorni dalla data di scadenza della transazione pianificata. Il numero di giorni n con cui segnalare in anticipo la scadenza di una transazione pianificata, può essere impostato o nella scheda Transazioni pianificate delle Preferenze di GnuCash o nella scheda Generali dell’Editor transazioni pianificate.

	Da creare
	La transazione pianificata verrà creata automaticamente alla pressione del pulsante Ok.

	Vuoto
	Un campo vuoto significa che non è prevista alcuna operazione per la transazione pianificata.






Nella parte inferiore della finestra sono presenti due pulsanti:
	Il pulsante Annulla permette di uscire dalla finestra Dall’ultimo avvio... senza creare le transazioni pianificate.

	Il pulsanteOk chiude la finestra Dall’ultimo avvio e applica le operazioni in sospeso.



Nella parte inferiore destra della finestra Dall’ultimo avvio... è possibile abilitare l’opzione Controlla le transazioni create. Abilitandola, quando sono presenti una o più transazioni Da creare, premendo il tasto Ok verrà aperta una finestra del registro in cui sono visualizzati dettagli della transazione inserita automaticamente da GnuCash

Modificare i fogli di stile



GnuCash fornisce quattro tipi predefiniti di fogli di stile per le pagine web dei resoconti. Questi fogli di stile possono essere modificati utilizzando l’editor HTML. Per accedervi, selezionare Modifica → Fogli di stile....
Utilizzando l’editor dei fogli di stile è possibile visualizzare e modificare le impostazioni di un foglio di stile.
Nota
Cambiando il foglio di stile, verrà modificato l’aspetto di tutti i resoconti a cui il foglio di stile è associato. È necessario eseguire il comando Aggiorna per visualizzare i cambiamenti, se il o i resoconti sono visualizzati al momento della modifica.

Per aggiungere un nuovo foglio di stile, selezionare il pulsante Nuovo... nel riquadro del foglio di stile; verrà visualizzata la finestra per il Nuovo foglio di stile. Immettere il Nome e selezionare un modello. Per rimuovere un foglio di stile, selezionarlo dalla lista e premere Elimina.
Foglio di stile predefinito



Il foglio di stile Predefinito presenta quattro schede per modificarne l’aspetto nei resoconti che lo utilizzano: Colori, Caratteri, Generali e Tabelle.
Scheda Colori



	Colore alternativo delle celle: il colore da alternare sulle righe della tabella.




Scheda Stili



	Titolo: selezionare il carattere e la dimensione per i titoli.

	Collegamento al conto: il carattere e la dimensione per il collegamento al conto.

	Cella numerica: selezionare il carattere e la dimensione dei numeri per le celle numeriche.

	Valori negativi in rosso: se attivata, i valori negativi saranno visualizzati in rosso.

	Cella di testo: selezionare il carattere e la dimensione del testo per le celle di testo.

	Cella del totale: selezionare il carattere e la dimensione per le celle del totale.

	Cella dell’etichetta del totale: selezionare il carattere e la dimensione del testo per la cella di intestazione dei totali.

	Cella con etichetta centrata: selezionare il carattere e la dimensione del testo delle celle con l’etichetta centrale.




Scheda Generali



	Colore dello sfondo: apre il selezionatore di colore per sceglierne uno nuovo.

	Immagine di sfondo: usare il pulsante Sfoglia per selezionare un’immagine da utilizzare come sfondo nei resoconti.

	Abilita collegamenti: se attivata, verranno visualizzati in blu i collegamenti ipertestuali nei resoconti.




Scheda Tabelle



	Spaziatura tra le celle: permette di specificare lo spazio tra le celle

	Imbottitura della cella: specifica lo spazio tra i bordi della cella e il suo contenuto.

	Larghezza del bordo della tabella: permette di impostare la larghezza dei bordi delle tabelle.





Foglio di stile Semplice



Il foglio di stile Semplice presenta quattro schede per modificare l’aspetto dei resoconti: colori, generali, immagini e tabelle.
Colori



	Colore dello sfondo: apre il selezionatore di colore per sceglierne uno nuovo.

	Colore del testo: apre il selezionatore del colore per sceglierne uno nuovo.

	Colore del testo della cella: apre il selezionatore del colore per sceglierne uno nuovo.

	Colore del collegamento: apre il selezionatore del colore per sceglierne uno nuovo.

	Colore alternativo delle celle: apre il selezionatore del colore per sceglierne uno nuovo.

	Colore della cella del sottotitolo e del subtotale: apre il selezionatore del colore per sceglierne uno nuovo.

	Colore della cella del sotto-sottotitolo e del totale: apre il selezionatore del colore per sceglierne uno nuovo.

	Colore della cella della somma complessiva: apre il selezionatore del colore per scegliere il colore da assegnare alle righe della somma complessiva.




Stili



	Titolo: selezionare il carattere e la dimensione per i titoli.

	Collegamento al conto: il carattere e la dimensione per il collegamento al conto.

	Cella numerica: selezionare il carattere e la dimensione dei numeri per le celle numeriche.

	Valori negativi in rosso: se attivata, i valori negativi saranno visualizzati in rosso.

	Intestazione: selezionare il carattere e la dimensione per l’intestazione.

	Cella di testo: selezionare il carattere e la dimensione del testo per le celle di testo.

	Cella del totale: selezionare il carattere e la dimensione per le celle del totale.

	Cella dell’etichetta del totale: selezionare il carattere e la dimensione del testo per la cella di intestazione dei totali.

	Cella con etichetta centrata: selezionare il carattere e la dimensione del testo delle celle con l’etichetta centrale.




Generali



	Redattore: Nome della persona che ha preparato il resoconto.

	Preparato per: Nome della società od organizzazione per cui il resoconto è stato preparato.

	Visualizza informazioni sul redattore: mostra le informazioni sul redattore nel resoconto.

	Abilita collegamenti: se attivata, verranno visualizzati in blu i collegamenti ipertestuali nei resoconti.




Immagini



	Immagine di sfondo: permette di ricercare una immagine da utilizzare come sfondo nei resoconti utilizzando il pulsante Sfoglia. Il pulsante Pulisci annulla la selezione.

	Striscione di intestazione: permette di ricercare una immagine da utilizzare come intestazione nei resoconti utilizzando il pulsante Sfoglia. Il pulsante Pulisci annulla la selezione.

	Allineamento dell’intestazione: selezionare dalla lista a discesa un valore tra sinistra, centro e destra per specificare la posizione dello striscione superiore del o dei resoconti.

	Logo: permette di ricercare una immagine da utilizzare come logo nei resoconti utilizzando il pulsante Sfoglia. Il pulsante Pulisci annulla la selezione.




Tabelle



	Spaziatura tra le celle: permette di specificare lo spazio tra le celle

	Imbottitura della cella: specifica lo spazio tra i bordi della cella e il suo contenuto.

	Larghezza del bordo della tabella: permette di impostare la larghezza dei bordi delle tabelle.





Fogli di stile Piè di pagina



Il foglio di stile Piè di pagina presenta le stesse cinque schede dello stile Easy per modificare l’aspetto dei resoconti: Colori, Stili, Generali, Immagini e Tabelle.
Colori



	Colore dello sfondo: apre il selezionatore di colore per sceglierne uno nuovo.

	Colore del testo: apre il selezionatore del colore per sceglierne uno nuovo.

	Colore del testo della cella: apre il selezionatore del colore per sceglierne uno nuovo.

	Colore del collegamento: apre il selezionatore del colore per sceglierne uno nuovo.

	Colore alternativo delle celle: apre il selezionatore del colore per sceglierne uno nuovo.

	Colore della cella del sottotitolo e del subtotale: apre il selezionatore del colore per sceglierne uno nuovo.

	Colore della cella del sotto-sottotitolo e del totale: apre il selezionatore del colore per sceglierne uno nuovo.

	Colore della cella della somma complessiva: apre il selezionatore del colore per scegliere il colore da assegnare alle righe della somma complessiva.




Stili



	Titolo: selezionare il carattere e la dimensione per i titoli.

	Collegamento al conto: il carattere e la dimensione per il collegamento al conto.

	Cella numerica: selezionare il carattere e la dimensione dei numeri per le celle numeriche.

	Valori negativi in rosso: se attivata, i valori negativi saranno visualizzati in rosso.

	Intestazione: selezionare il carattere e la dimensione per l’intestazione.

	Cella di testo: selezionare il carattere e la dimensione del testo per le celle di testo.

	Cella del totale: selezionare il carattere e la dimensione per le celle del totale.

	Cella dell’etichetta del totale: selezionare il carattere e la dimensione del testo per la cella di intestazione dei totali.

	Cella con etichetta centrata: selezionare il carattere e la dimensione del testo delle celle con l’etichetta centrale.




Generali



	Redattore: Nome della persona che ha preparato il resoconto.

	Preparato per: Nome della società od organizzazione per cui il resoconto è stato preparato.

	Visualizza informazioni sul redattore: mostra le informazioni sul redattore nel resoconto.

	Abilita collegamenti: se attivata, verranno visualizzati in blu i collegamenti ipertestuali nei resoconti.

	Piè di pagina: il testo da inserire a piè pagina del resocoto.




Immagini



	Immagine di sfondo: permette di ricercare una immagine da utilizzare come sfondo nei resoconti utilizzando il pulsante Sfoglia. Il pulsante Pulisci annulla la selezione.

	Striscione di intestazione: permette di ricercare una immagine da utilizzare come intestazione nei resoconti utilizzando il pulsante Sfoglia. Il pulsante Pulisci annulla la selezione.

	Allineamento dell’intestazione: selezionare dalla lista a discesa un valore tra sinistra, centro e destra per specificare la posizione dello striscione superiore del o dei resoconti.

	Logo: permette di ricercare una immagine da utilizzare come logo nei resoconti utilizzando il pulsante Sfoglia. Il pulsante Pulisci annulla la selezione.




Tabelle



	Spaziatura tra le celle: permette di specificare lo spazio tra le celle

	Imbottitura della cella: specifica lo spazio tra i bordi della cella e il suo contenuto.

	Larghezza del bordo della tabella: permette di impostare la larghezza dei bordi delle tabelle.





Foglio di stile Technicolor



Il foglio di stile Technicolor fornisce cinque schede per modificare l’aspetto dei resoconti: Colori, Stili, Generali, Immagini e Tabelle.
Colori



	Colore dello sfondo: apre il selezionatore di colore per sceglierne uno nuovo.

	Colore del testo: apre il selezionatore del colore per sceglierne uno nuovo.

	Colore del testo della cella: apre il selezionatore del colore per sceglierne uno nuovo.

	Colore del collegamento: apre il selezionatore del colore per sceglierne uno nuovo.

	Colore alternativo delle celle: apre il selezionatore del colore per sceglierne uno nuovo.

	Colore della cella del sottotitolo e del subtotale: apre il selezionatore del colore per sceglierne uno nuovo.

	Colore della cella del sotto-sottotitolo e del totale: apre il selezionatore del colore per sceglierne uno nuovo.

	Colore della cella della somma complessiva: apre il selezionatore del colore per scegliere il colore da assegnare alle righe della somma complessiva.




Stili



	Titolo: selezionare il carattere e la dimensione per i titoli.

	Collegamento al conto: il carattere e la dimensione per il collegamento al conto.

	Cella numerica: selezionare il carattere e la dimensione dei numeri per le celle numeriche.

	Valori negativi in rosso: se attivata, i valori negativi saranno visualizzati in rosso.

	Intestazione: selezionare il carattere e la dimensione per l’intestazione.

	Cella di testo: selezionare il carattere e la dimensione del testo per le celle di testo.

	Cella del totale: selezionare il carattere e la dimensione per le celle del totale.

	Cella dell’etichetta del totale: selezionare il carattere e la dimensione del testo per la cella di intestazione dei totali.

	Cella con etichetta centrata: selezionare il carattere e la dimensione del testo delle celle con l’etichetta centrale.




Generali



	Redattore: Nome della persona che ha preparato il resoconto.

	Preparato per: Nome della società od organizzazione per cui il resoconto è stato preparato.

	Visualizza informazioni sul redattore: mostra le informazioni sul redattore nel resoconto.

	Abilita collegamenti: se attivata, verranno visualizzati in blu i collegamenti ipertestuali nei resoconti.




Immagini



	Immagine di sfondo: permette di ricercare una immagine da utilizzare come sfondo nei resoconti utilizzando il pulsante Sfoglia. Il pulsante Pulisci annulla la selezione.

	Striscione di intestazione: permette di ricercare una immagine da utilizzare come intestazione nei resoconti utilizzando il pulsante Sfoglia. Il pulsante Pulisci annulla la selezione.

	Allineamento dell’intestazione: selezionare dalla lista a discesa un valore tra sinistra, centro e destra per specificare la posizione dello striscione superiore del o dei resoconti.

	Logo: permette di ricercare una immagine da utilizzare come logo nei resoconti utilizzando il pulsante Sfoglia. Il pulsante Pulisci annulla la selezione.




Tabelle



	Spaziatura tra le celle: permette di specificare lo spazio tra le celle

	Imbottitura della cella: specifica lo spazio tra i bordi della cella e il suo contenuto.

	Larghezza del bordo della tabella: permette di impostare la larghezza dei bordi delle tabelle.






Guida ai concetti e manuale di GnuCash



La guida è il complemento a questo aiuto; spiega infatti i concetti utilizzati in GnuCash e presenta un esempio che accompagna l’utente attraverso tutte le fasi dell’utilizzo di GnuCash per gestire i propri conti. La guida verrà aperta se si sceglie Aprire la guida per i nuovi utenti nella finestra di Benvenuto in GnuCash!.
Per aprire questa guida selezionare Aiuto → Guida ai concetti e manuale dal menu.
Si raccomanda di leggere questa guida se si sta utilizzando GnuCash per la prima volta o se non si ha familiarità con i concetti della contabilità.

Registro del conto/Libro mastro generale



Registro del conto e finestra del libro mastro generale



Questa finestra è utilizzata per l’inserimento e la modifica dei dati del conto; fornisce anche degli strumenti per la pianificazione futura delle transazioni, per cercare e per creare dei resoconti sulle transazioni e per la stampa degli assegni.
Per aprire la finestra del registro di un conto, selezionare quest’ultimo nella struttura dei conti e poi andare in File → Apri conto  o premere Ctrl+O: verrà aperta una nuova finestra con il registro del conto. Il pulsante Apri nella barra degli strumenti della finestra della struttura dei conti o il pulsante Salta nella finestra del registro, sono delle possibili alternative.
Figura 4.3. La visualizzazione del registro del conto.
[image: Schermata del registro del conto]Questa è una schermata della scheda Registro del conto.







Menu del registro dei conti



La barra del menu per la finestra del registro delle transazioni, contiene le seguenti opzioni:
Registro del conto - Menu File



La tabella seguente descrive le opzioni del menu File.
Selezionando la voce File sulla barra del menu, comparirà un menu a discesa contenente le opzioni descritte in Tabella 4.11, «Registro del conto - Menu File - Permette l’accesso ai file, alle operazioni sui conti e alla stampa.».
Tabella 4.11. Registro del conto - Menu File - Permette l’accesso ai file, alle operazioni sui conti e alla stampa.
	Voce del menu
	Descrizione
	
                  Nuovo file (Ctrl+N)
                
	
                  Crea un nuovo file dei dati (per iniziare con dei nuovi conti e dei nuovi dati)

	
                  Apri... (Ctrl+O)
                
	
                  Apre un file dei dati di GnuCash già esistente.

	Importa → 
	
                  Apre il menu secondario che permette l’importazione dei file creati con altri programmi finanziari.

	 	
                  Importa QIF...
	
                  Avvia il processo di importazione di file QIF.

	 	
                  Importa OFX/QFX...
	
                  Avvia il processo di importazione di file OFX/QFX.

	 	
                  Importa file CSV o a larghezza fissa...
	
                  Avvia il processo di importazione di file CSV o a larghezza fissa.

	 	
                  Ripeti file log di GnuCash...
	
                  Avvia la ripetizione di un file di log di GnuCash. Utilie per recuperare i dati dopo un crash del programma.

	 	
                  Importa MT940
	
                  .

	 	
                  Importa MT942
	
                  .

	 	
                  Importa DTAUS
	
                  .

	 	
                  Importa DTAUS e invia
	
                  .

	
                  Salva (Ctrl+S)
                
	
                    Salva il file attualmente aperto.

                  
	
                  Salva come... (Maiusc+Ctrl+S)
                
	
                    Salva il file attualmente aperto con un altro nome.

                    Avvertimento
NON salvare i file dei dati in ~/.gnucash/books.


                  
	
                  Stampa assegni... (Ctrl+P)
                
	
                    Avvia l’assistente per la stampa degli assegni. Consultare la sezione chiamata «Stampare gli assegni».

                  
	
                  Imposta pagina... (Maiusc+Ctrl+P)
                
	
                  Permette di selezionare la dimensione del foglio, la disposizione e i margini per la stampa.

                
	Apre il menu secondario con le voci relative all’esportazione dei conti. → 
	
                  Apre il menu secondario con le voci relative all’esportazione dei conti.

	 	
                  Esporta conti
	
                  Esporta la struttura dei conti in un nuovo file. I dati non vengono esportati.

	
                  Proprietà (Alt+Inserisci)
                
	
                    Impostazione delle opzioni per il file di GnuCash corrente.

                  
	File aperti di recente
	
                    Lista numerata dei file aperti più di recente daGnuCash.

                  
	
                  Chiudi (Ctrl+W)
                
	
                    Chiude la struttura dei conti, il registro delle transazioni o il resoconto aperti. Per la struttura dei conti iniziale questa voce non è disponibile (non è selezionabile).

                  
	
                  Esci (Ctrl+Q)
                
	
                    Esce da GnuCash.

                  





Registro del conto - Menu Modifica



Tabella 4.12. Registro del conto - Menu Modifica - Accede alle operazioni e alle preferenze dei conti e dei dati.
	Voce del menu
	
                    Descrizione

                  
	
                  Taglia (Ctrl+X)
                
	
                    Esegue una operazione standard di Taglio.

                  
	
                  Copia (Ctrl+C)
                
	
                    Esegue una operazione standard di Copia.

                  
	
                  Incolla (Ctrl+V)
                
	
                    Esegue una operazione standard di incollaggio.

                  
	Modifica conto
	
                    Apre la scheda per la modifica delle caratteristiche e dei parametri del conto.

                  
	
                  Trova... (Ctrl+F)
                
	
                    Permette di impostare i criteri di ricerca per una specifica transazione. Consultare la la sezione chiamata «Trovare le transazioni» per maggiori dettagli sulla funzione di ricerca.

                  
	Preferenze (GnuCash → Preferenze su Mac OS X).
	
                    Personalizzazione di GnuCash per quanto riguarda la posizione, lo stile e tante altre opzioni. Consultare la sezione chiamata «Impostare le preferenze».

                  
	Fogli di stile
	
                    Permette di modificare e personalizzare i fogli di stile.

                  
	Opzioni resoconto tasse
	
                    Imposta le caratteristiche delle tasse per uno o più conti (US). Assign tax form and line to account.

                  





Registro del conto - Menu Visualizza



Tabella 4.13. Registro del conto - Menu Visualizza - Modifica le opzioni di visualizzazione della finestra di GnuCash.
	Voce del menu
	
                    Descrizione

                  
	Barra degli strumenti
	
                    Selezione per abilitare o disabilitare la visualizzazione della barra degli strumenti.

                  
	Barra di riepilogo
	
                    Opzione per abilitare o disabilitare la visualizzazione della barra di riepilogo.

                  
	Barra di stato
	
                    Opzione per abilitare o disabilitare la visualizzazione della barra di stato.

                  
	Libro mastro basilare
	
                Opzione per la scelta dello stile di visualizzazione del registro.

	Mastro a espansione automatica
	
                Opzione per la scelta dello stile di visualizzazione del registro.

	Giornale della transazione
	
                Opzione per la scelta dello stile di visualizzazione del registro.

	Doppia linea
	
                Opzione per abilitare o disabilitare la visualizzazione a doppia linea.

	Ordina per...
	
                Imposta il criterio di ordinamento della schermata delle transazioni. Fare clic per aprire la scheda delle opzioni. Per chiudere la scheda delle opzioni premere i pulsanti Annulla o OK.

	 	
                Ordine standard
	
                Mantiene l’ordine normale del conto

	 	
                Data
	
                Ordina per data

	 	
                Data di immissione
	
                Ordina per data di immissione.

	 	
                Data dell’estratto conto
	
                Ordina per data dell’estratto conto (elementi non riconciliati per ultimi).

	 	
                Numero
	
                Ordina per numero.

	 	
                Importo
	
                Ordina per importo.

	 	
                Promemoria
	
                Ordina per promemoria.

	 	
                Descrizione
	
                Ordina per descrizione.

	 	
                Operazioni
	
                Ordina per operazione

	 	
                Note
	
                Ordina per campo delle note

	Filtra per...
	Imposta il filtro per i conti visualizzati nella struttura dei conti o nella schermata del registro delle transazioni.

	
                  Aggiorna (Ctrl+R)
                
	Ridisegna la schermata visualizzata.

                  
	Nuova pagina dei conti
	Apre una nuova scheda in cui è visualizzata la struttura dei conti.
	 





Registro del conto - Menu Transazione



Tabella 4.14. Registro del conto - Menu Transazione - accede alle operazioni di modifica della transazione.
	Voce del menu
	Descrizione
	Taglia transazione
	Taglia la transazione selezionata e la mantiene in memoria.

	Copia transazione
	Copia la transazione selezionata nella memoria.

	Incolla transazione
	Incolla la transazione selezionata dalla memoria.

	Duplica transazione
	Inserisce nel registro una copia della transazione selezionata.

	Elimina transazione
	Cancella la transazione selezionata.

	Rimuovi suddivisioni dalla transazione
	Rimuove tutte le suddivisioni dalla transazione selezionata.

	Inserisci transazione
	Inserisce nel registro la transazione a cui si sta lavorando

	Annulla transazione
	

	Invalida transazione
	Invalida la transazione selezionata.

	Riconvalida transazione
	Riconvalida la transazione selezionata.

	Aggiungi transazione di inversione
	






Registro del conto - Menu Operazioni



Tabella 4.15. Registro del conto - Menu Operazioni - Permette di impostare le transazioni pianificate, di riparare i conti, di effettuare dei frazionamenti azionari, di trasferire del denaro e di riconciliare le transazioni.
	Voce del menu
	Descrizione
	Operazioni online → 
	Questa voce del menu è mostrata solamente se è abilitato l’Online Banking GnuCash
	 	
                  Ricevi saldo
	
                  

	 	
                  Ricevi transazioni
	
                  Scarica le transazioni dai conti online

	 	
                  Inoltra transazione...
	
                  Invia una o più transazioni a un conto online

	 	
                  Transazione interna...
	
                  

	 	
                  Addebito diretto...
	
                  

	Transazioni pianificate → 
	menu secondari della voce «transazioni pianificate»
	 	
                  Editor transazioni pianificate
	
                  Richiama lo strumento di modifica di una transazione pianificata. Vedere la la sezione chiamata «Finestra di modifica della transazione pianificata»

	 	
                  Dall’ultimo avvio
	
                  Mostra le transazioni pianificate dall’ultimo avvio di GnuCash. la sezione chiamata «Assistente dall’ultimo avvio»

	 	
                  Rimborso di mutui e ipoteche...
	
                  Avvia l’assistente di rimborso di mutui e ipoteche per impostare le rate. la sezione chiamata «Assistente per mutui e ipoteche»

                
	Bilancio → 
	Menu secondario per l’impresa
	 	
                  Nuovo bilancio preventivo
	
                  Apre la finestra per la creazione di un nuovo bilancio preventivo.

	 	
                  Apri bilancio preventivo
	
                  Apre un bilancio esistente.

	
                  Trasferimenti... (Ctrl+T)
                
	
                  Avvia la procedura di trasferimento tra conti.

	Riconcilia...
	
                  Avvia la procedura di riconciliazione. la sezione chiamata «Finestra delle informazioni di riconciliazione»

	Frazionamento azionario...
	
                  Avvia l’assistente per il frazionamento azionario. Ulteriori dettagli nella la sezione chiamata «Registrare un frazionamento azionario».

	Visualizza lotti...
	
                  Apre la schermata dei lotti nel conto.

	Transazione vuota
	
               Sposta la selezione alla transazione vuote sul fondo del registro

              
	Transazione suddivisa
	Espande la transazione selezionata mostrandone le suddivisioni.

	Modifica tasso di cambio
	
               Modifica il tasso di cambio della transazione selezionata.

	Pianifica...
	
               Crea una transazione pianificata utilizzando questa transazione come modello.

	Salta
	
               Salta alla transazione corrispondente nell’altro conto.

	Controlla e ripara → 
	
                    Menu secondari della voce Controlla e ripara

                  
	 	
                    Tutte le transazioni

                  	
                    Ricerca e ripara le transazioni non in bilancio e le suddivisioni orfane nel conto selezionato.

                  
	 	
                    Questa transazione

                  	
                    Controlla e ripara le suddivisioni in questa transazione.

                  
	Ripristina avvisi...
	
                  GnuCash visualizza degli avvisi quando si cerca di effettuare determinate operazioni, come rimuovere una transazione o le suddivisioni da una transazione. La finestra di avviso presenta l’opzione di non visualizzare più questi messaggi alla ripetizione dell’operazione. Le opzioni Ricordalo e non chiedermelo di nuovo e Ricordalo e non chiedermelo di nuovo in questa sessione, permettono di disabilitarli. L’opzione Ripristina avvisi permette di ripristinare gli avvisi predefiniti, cioè abilita la visualizzazione dei messaggi.

                  
	Rinomina pagina
	
                   Apre la casella per rinominare la scheda o la pagina corrente.

                  





Registro del conto - Menu Impresa



Gli elementi visualizzati nel menu Impresa sono gli stessi elencati in Tabella 4.5, «Struttura dei conti - Menu Impresa - permette l’accesso alle funzioni di GnuCash dedicate all’impresa.».

Registro del conto - Menu Resoconti



Gli elementi visualizzati nel menu Resoconti sono gli stessi elencati in Tabella 4.6, «Struttura dei conti - Menu Resoconti - Permette la scelta dei resoconti e dei grafici forniti da GnuCash.» a cui si aggiungono quelli elencati nel seguito.
	Resoconto del conto

	Resoconto delle transazioni del conto




Registro del conto - Menu Strumenti



Gli elementi visualizzati nel menu Strumenti sono gli stessi elencati in Tabella 4.7, «Struttura dei conti - Menu Strumenti - Permette l’accesso a diversi strumenti e editor».

Registro del conto - Menu Finestre



Gli elementi visualizzati nel menu Finestre sono gli stessi elencati in Tabella 4.8, «Struttura dei conti - Menu Finestre».

Registro del conto - Menu Aiuto



Gli elementi visualizzati nel menu Aiuto sono gli stessi elencati in Tabella 4.9, «Struttura dei conti - Menu Aiuto - Permette l’accesso a questo documento e alla guida ai concetti e manuale.».


Registro del conto - Icone e pulsanti della barra degli strumenti



La finestra principale di GnuCash mette a disposizione una serie di pulsanti e icone utili per accedere facilmente alle funzioni più comunemente utilizzate nella scheda attiva. La barra degli strumenti può essere facilmente nascosta o visualizzata selezionando la voce Barra degli strumenti dal menu Visualizza. Le opzioni visualizzate nella barra variano a seconda delle operazioni eseguibili nella scheda attiva.
Nota
Le opzioni specifichevisualizzate nella barra degli strumenti variano in funzione delle operazioni disponibile nella scheda corrente.

Una breve descrizione della funzione di un pulsante è visualizzata quando il puntatore del mouse viene mantenuto al di sopra di essa per qualche secondo.
Tabella 4.16. Barra degli strumenti della finestra del registro del conto (registro delle transazioni)
	Pulsanti della Barra degli strumenti
	Descrizione

	
                  Salva (Ctrl+S)
                
	Esegue il salvataggio del file dei dati, inserendo tutte le transazioni nel file.

	Chiudi
	Chiude il registro.

	Duplica
	Permette di creare una copia della transazione selezionata.

	Cancella
	Cancella dal registro la transazione selezionata.

	Inserisci
	Registra la transazione corrente.

	Annulla
	Annulla la transazione corrente.

	Vuota
	Sposta il cursore nella transazione vuota alla fine del registro.

	Suddivisione
	Mostra tutte le suddivisioni nella transazione selezionata. Questo pulsante è disattivato se è stato scelta l’opzione Visualizza → Mastro a espansione automatica

	Salta
	Salta alla transazione corrispondente nell’altro conto

              
	Pianifica
	Crea una transazione pianificata utilizzando questa transazione come modello.

	Trasferimento
	Avvia l’assistente per il trasferimento di fondi da un conto a un altro.

	Riconcilia
	Avvia il procedimento di riconciliazione per il conto selezionato. la sezione chiamata «Finestra delle informazioni di riconciliazione»

              





Barra delle schede



La barra delle schede visualizza in stile «fascicolatore» le schede per i registri delle transazioni, per i resoconti e per le strutture dei conti aperti.

Elenco delle transazioni



L’elenco delle transazioni visualizza tutti i movimenti che sono stati inseriti e un saldo corrente. Presenta anche una transazione vuota da utilizzare per inserire dei nuovi movimenti. Le intestazioni delle colonne variano in funzione del tipo di conto a cui il registro si riferisce. Le intestazioni più comunemente visualizzate sono Data, Descrizione, Trasferimento e Saldo.
Il menu Visualizza permette di modificare lo stile di visualizzazione dell’elenco delle transazioni variando il numero di elementi visualizzati, utilizzando un criterio di ordinamento differente oppure cambiando lo stile per poter visualizzare più facilmente le transazioni. Il pulsante Suddivisione permette di mostrare velocemente tutte le parti di una transazione.

Barra di riepilogo



La barra di riepilogo visualizza dei saldi relativi al tipo di conto aperto. Normalmente i conti visualizzano il saldo Attuale, il saldo Futuro, un saldo per le operazioni liquidate, un saldo di riconciliazione e un saldo Minimo previsto. I conti per le azioni, inoltre, visualizzano le quote totali e il loro valore. La barra di riepilogo puVisualizzaBarra di riepilogo dal menu.

Barra di stato



La barra di stato funziona esattamente come già descritto in la sezione chiamata «Barra di stato».


9. TERMINATION



You may not copy, modify, sublicense, or distribute the Document except as expressly provided for under this License. Any other attempt to copy, modify, sublicense or distribute the Document is void, and will automatically terminate your rights under this License. However, parties who have received copies, or rights, from you under this License will not have their licenses terminated so long as such parties remain in full compliance.

Stampare gli assegni



In GnuCash gli assegni sono stampati dal registro del conto. GnuCash fornisce la possibilità di stampare assegni con lo standard Quicken (anche nel formato US Letter) o di creare un formato personalizzato. Anche la posizione dell’assegno e il formato della data sono personalizzabili.
Per stampare un unico assegno in GnuCash, selezionare la transazione di cui stampare l’assegno e andare in File → Stampa assegni. Verrà aperta la finestra delle proprietà per la stampa dell’assegno.
Per stampare più assegni in GnuCash eseguire una ricerca per trovare le transazioni che si intende stampare. Dalla finestra dei risultati della ricerca andare in File → Stampa assegni. Verrà aperta la finestra delle proprietà di stampa degli assegni per stampare tutti gli assegni presenti nella finestra di ricerca.
La finestra per la stampa dell’assegno presenta due schede. La prima è denominata Opzioni e permette di impostare le opzioni più comuni per la stampa dell’assegno; la seconda, denominata Formato personalizzato permette di configurare la posizione dei vari campi sull’assegno. È utile a questo scopo stampare un assegno di prova su un foglio di carta e utilizzarlo per effettuare le correzioni necessarie.
La selezione preimpostata nella finestra delle Opzioni è l’assegno Quicken/Quickbooks (tm) US-Letter.
	Formato dell’assegno: provare prima con il formato Quicken e utilizzare il formato personalizzato se la posizione non è corretta.

	Posizione dell’assegno: permette di selezionare l’assegno da stampare: Top (in alto), Middle (in mezzo) o Bottom (in basso). L’opzione Personalizzato è da selezionare se la posizione degli assegni nella pagina non è corretta.

	Formato data: il valore predefinito visualizzato in questo campo è impostato nelle preferenze di GnuCash. Dalla lista a comparsa è possibile selezionare il formato della data desiderato. Il formato può essere cambiato utilizzando le righe denominate Mesi: e Anni:. Scegliendo Personalizzato sarà possibile impostare il formato della data nel campo Formato: (%m significa mese, %d significa giorno, %Y significa anno). Un esempio del formato selezionato è mostrato appena più sotto nella finestra.

	Indirizzo: l’indirizzo del beneficiario, se il formato dell’assegno contiene uno spazio dedicato e se si intende stampare un unico assegno.



La scheda del Formato personalizzato è divisa in due sezioni. La metà superiore (al di sopra della linea di divisione) contiene due colonne per l’inserimento delle coordinate X e Y della posizione del campo sull’assegno. Le posizioni nel formato di assegno personalizzato sono a partire da x = 0 sul lato sinistro dell’assegno, crescenti verso destra, e y = 0 dal lato superiore dell’assegno, crescenti verso il basso. (Se si utilizza una versione di GTK precedente alla 2.10, allora y = 0 è al bordo inferiore e positiva verso l’alto).
	Beneficiario:

	Data:

	Importo (in parole):

	Importo (in numeri):

	Indirizzo:

	Note:

	Promemoria:

	Importo suddivisioni

	Promemoria suddivisioni

	Conto suddivisioni



La parte della scheda del Formato personalizzato al di sotto della linea di divisione contiene i campi per il posizionamento dell’assegno all’interno della pagina. La Traslazione è la distanza dall’angolo superiore sinistro mentre la Rotazione rappresenta la rotazione in senso orario dell’assegno. 
Il campo Unità nella metà inferiore della finestra indica le unità da utilizzare per i campi in entrambe le metà della finestra.
Una volta che è stato premuto il tasto OK nella finestra di stampa dell’assegno, verrà visualizzata la finestra per la stampa di un documento di GnuCash. Premere di nuovo OK per stampare l’assegno.

Pseudo simboli da utilizzare per le quotazioni TIAA-CREF



Tabella A.2. Pseudo simboli da utilizzare per le quotazioni TIAA-CREF
	Nome
	Pseudo-simbolo

	Mercato delle obbligazioni
	CREFbond

	Indice del capitale
	CREFequi

	Capitali globali
	CREFglob

	Growth
	CREFgrow

	Obbligazioni legate all’inflazione
	CREFinfb

	Mercato monetario
	CREFmony

	Social Choice
	CREFsoci

	Azioni
	CREFstok

	Teachers PA Select Stock
	TIAAsele

	Teachers PA Stock Index
	TIAAsndx

	TIAA Real Estate
	TIAAreal






Finestra di trasferimento fondi



Il metodo descritto di seguito utilizza la finestra del trasferimento fondi per inserire una singola transazione. Questo procedimento permette di inserire con rapidità una singola transazione senza bisogno di aprire la finestra del registro. Per inserire delle transazioni multiple, si consiglia di utilizzare direttamente il registro. La finestra del trasferimento fondi è accessibile da Operazioni → Trasferisci, o premendo il pulsante Trasferimento presente nella scheda del registro del conto.
	Inserire nel riquadro delle Informazioni di base l’Importo, la Data e una Descrizione. Il Numero e il Promemoria sono opzionali.

	Selezionare il conto Trasferisci da. Se questo conto appartiene alle entrate o alle uscite abilitare l’opzione apposita al di sotto del riquadro Trasferisci da.

	Selezionare il conto Trasferisci da. Se questo conto appartiene alle entrate o alle uscite abilitare l’opzione apposita al di sotto del riquadro Trasferisci da.

	Se i due conti hanno una valuta differente, verrà abilitata la sezione per il trasferimento in valuta dove sarà possibile inserire il Tasso di cambio o un Importo a.

	Selezionare OK per inserire la transazione o Annulla per chiudere la finestra senza inserire la transazione.




Appendice A. Suggerimenti e consigli utili su GnuCash

Versione 1.0, dicembre 2006



Codici delle borse per i mercati Europei



Lista dei codici delle borse per i mercati Europei
Tabella A.1. Lista dei codici delle borse per i mercati Europei
	Codice
	Mercato

	BC
	Barcellona

	BE
	Berlino

	BI
	Bilbao

	BR
	Brême

	CO
	Copenhagen

	D
	Dusseldorf

	F
	Francoforte

	DE
	Xetra (was FX)

	H
	Hamburg

	HA
	Hanover

	L
	Londra

	MA
	Madrid

	MC
	Madrid (M.C.)

	MI
	Milano

	MU
	Monaco

	O
	Oslo

	PA
	Parigi

	ST
	Stoccolma

	SG
	Stuttgart

	VA
	Valence

	VI
	Vienna







Cancellare una transazione



Se è necessario rimuovere una transazione dal registro, selezionarla e premere il pulsante Elimina nella barra degli strumenti oppure andare in Transazioni → Elimina transazione. Verrà visualizzata una finestra di conferma dell’eliminazione, a meno che non siano state cambiate le preferenze. La finestra propone due opzioni 
È possibile rimuovere anche solo alcune parti della transazione premendo il pulsante Suddivisione sulla barra degli strumenti o selezionando Operazioni → Suddividi transazione. La parte della transazione da cancellare può essere poi selezionata per l’eliminazione.

Importare i file QIF



Questo assistente assiste nell’importazione di file Quiken (QIF). Verrà aperto se si seleziona Importare file QIF nella finestra di Benvenuto in GnuCash!.
Per avviare manualmente l’assistente, andare in File → Importa... → Importa QIF....
Nel seguito tutte le schermate che possono essere visualizzate in questo assistente sono descritte in ordine di apparizione.
	L’ assistente per l’Importazione dei file QIF si avvia presentando una finestra contenente una breve descrizione delle sue funzionalità. I tre pulsanti in basso nella finestra non cambieranno durante tutte le fasi di utilizzo dell’assistente.
	Annulla — esce dal processo e annulla l’importazione di file QIF.
Avvertimento
Se si preme questo pulsante, qualsiasi selezione fatta fino a questo punto verrà persa.


	Indietro — fa apparire la schermata precedente in modo da poter modificare una selezione fatta in quella finestra.

	Avanti —  permette di avanzare nella procedura guidata.




	Nella schermata successiva verrà richiesto di Scegliere un file QIF da caricare. Il pulsante Seleziona... in questa finestra permette di accedere alla lista di file e cartelle aprendo il dialogo per Scegliere il file QIF.
Navigare fino alla posizione in cui sono stati salvati i propri file QIF; selezionare il primo fra quelli che si desidera importare e premere Importa. La schermata successiva visualizzerà il nome del file nella finestra per Scegliere il file QIF da importare..
Nota
Se il file che si sta caricando non possiede una data QIF verrà visualizzata la finestra per Impostare un formato di data per il file QIF. Selezionare quello appropriato dal menu a comparsa e continuare.

Nota
Se il file che si sta caricando non contiene un nome del conto verrà visualizzata la finestra per Impostare il nome predefinito del conto QIF. Diversamente verrà invece visualizzata la finestra descritta nella prossima sezione dove saranno visualizzati i file QIF caricati.
	Il campo del Nome del conto: permette di impostare un nome del conto per il file QIF.





	La pagina successiva visualizza i File QIF che sono stati caricati. È possibile tornare alla pagina precedente e selezionare altri file QIF. Qui è anche possibile eliminare qualsiasi file che sia stato caricato per errore.
	Il pannello superiore visualizza l’elenco dei file QIF che sono stati caricati.

	Il pulsante Carica un altro file riporta alla schermata precedente per aggiungere alla lista un ulteriore file QIF.

	Il pulsante Scarta il file selezionato permette, dopo aver selezionato un file nell’elenco presente nel riquadro superiore, di rimuoverlo dall’elenco.



Quando sono stati selezionati tutti i file QIF da importare, fare clic sul pulsanti Avanti.

	A seconda del tipo di dati contenuti nei file QIF da importare, verranno visualizzate una o più delle seguenti schermate:
	Conti e azioni
	Questa schermata fornisce una descrizione del processo di associazione di Conti e azioni che avverrà nella schermata successiva relativa all’Associazione dei conti QIF ai conti di GnuCash.
Suggerimento
Questa e le altre schermate informative dell’assistente all’Importazione di file QIF possono essere disabilitate nella scheda Online Banking (la sezione chiamata «Online Banking») delle Preferenze di GnuCash.

La pagina successiva permette l’Associazione dei conti QIF ai conti di GnuCash. Verrà mostrata una lista di Nomi dei conti QIF a sinistra e, a destra, il Nome del conto GnuCash suggerito. La colonna Nuovo? indica se il nome del conto di GnuCash verrà creato dalla procedura di importazione.
Per cambiare il conto di GnuCash è necessario selezionare il conto QIF; apparirà una finestra in cui sarà possibile selezionare un altro conto o crearne uno nuovo.
	Selezionare un conto dalla lista per utilizzarne uno già esistente.

	Il pulsante Nuovo conto permette di aggiungere un nuovo nome di conto come sottoconto (figlio) del conto selezionato.

	Il pulsante OK permette di confermare la selezione.

	Il pulsante Annulla permette di uscire dalla finestra di dialogo scartando tutte le scelte effettuate.




	Categorie di entrate e uscite
	Questa schermata fornisce una descrizione del processo di associazione delle Categorie di entrate e uscite nella schermata successiva relativa all’Associazione delle categorie QIF ai conti di GnuCash.
Suggerimento
Questa e le altre schermate informative dell’assistente all’Importazione di file QIF possono essere disabilitate nella scheda Online Banking (la sezione chiamata «Online Banking») delle Preferenze di GnuCash.

La pagina successiva permette l’Associazione delle categorie QIF ai conti di GnuCash. Verrà mostrata una lista di Nomi della categoria QIF a sinistra e, a destra, il Nome del conto GnuCash suggerito. La colonna Nuovo? indica se il nome del conto di GnuCash verrà creato dalla procedura di importazione.
Per cambiare il conto di GnuCash è necessario selezionare la categoria QIF; apparirà una finestra in cui sarà possibile selezionare un altro conto o crearne uno nuovo.
	Selezionare un conto dalla lista per utilizzarne uno già esistente.

	Il pulsante Nuovo conto permette di aggiungere un nuovo nome di conto come sottoconto (figlio) del conto selezionato.

	Il pulsante OK permette di confermare la selezione.

	Il pulsante Annulla permette di uscire dalla finestra di dialogo scartando tutte le scelte effettuate.




	Beneficiari e promemoria
	Questa schermata fornisce una descrizione del processo di associazione di Beneficiari e promemoria che avverrà nella schermata di Associazione di beneficiari e promemoria ai conti di GnuCash.
Suggerimento
Questa e le altre schermate informative dell’assistente all’Importazione di file QIF possono essere disabilitate nella scheda Online Banking (la sezione chiamata «Online Banking») delle Preferenze di GnuCash.

La pagina successiva permette l’Associazione di beneficiari e promemoria ai conti di GnuCash. Verrà mostrata una lista di Nomi di beneficiari e promemoria QIF a sinistra e, a destra, i Nomi dei conti di GnuCash suggeriti. Il conto predefinito di GnuCash utilizzato in questa fase ha un nome Non specificato. La colonna Nuovo? indica se il nome del conto di GnuCash verrà creato dalla procedura di importazione.
Per cambiare il conto di GnuCash è necessario selezionare il beneficiario e promemoria QIF; apparirà una finestra in cui sarà possibile selezionare un altro conto o crearne uno nuovo.
	Selezionare un conto dalla lista per utilizzarne uno già esistente.

	Il pulsante Nuovo conto permette di inserire un nuovo nome di conto come sottoconto del conto selezionato.

	Il pulsante OK permette di confermare la selezione.

	Il pulsante Annulla permette di uscire dalla finestra di dialogo scartando tutte le scelte effettuate.







	La schermata successiva consente di Immettere la valutadel file QIF. La lista a comparsa fornisce la valuta predefinita configurata nella scheda Conti (la sezione chiamata «Conti»)delle Preferenze di GnuCash. Per utilizzarne una diversa, selezionarla dalla lista.
Dopo aver selezionato la valuta, premere Avanti.

	A seconda del tipo di dati contenuti nei file QIF da importare, potrebbero essere visualizzate una o più delle seguenti schermate:
	Commodity scambiabili
	Questa schermata fornisce una descrizione del processo delle Commodity scambiabili.
Suggerimento
Questa e le altre schermate informative dell’assistente all’Importazione di file QIF possono essere disabilitate nella scheda Online Banking (la sezione chiamata «Online Banking») delle Preferenze di GnuCash.

Una serie di schermate per ogni azione, fondo comune o commodity, visualizza il cambio, il nome comnpleto e il simbolo per ogni commodity elencata nel file QIF che si sta importando in modo che sia possibile controllarne le informazioni prima di procedere.

	Transazioni corrispondenti
	Questa schermata fornisce una descrizione del processo di associazione delle Transazioni corrispondenti che avverrà nella seguente schermata di Selezione dei possibili duplicati.
Suggerimento
Questa e le altre schermate informative dell’assistente all’Importazione di file QIF possono essere disabilitate nella scheda Online Banking (la sezione chiamata «Online Banking») delle Preferenze di GnuCash.

La schermata successiva permette di Selezionare  i possibili duplicati tra le transazioni. Le transazioni importate sono visualizzate nel riquadro di sinistra e le possibili transazioni corrispondenti sono riportate a destra.
	Il riquadro di sinistra mostra l’elenco delle transazioni importate tra cui selezionare i duplicati.

	Il riquadro di destra mostra l’elenco dei possibili duplicati delle transazioni selezionate per l’importazione. Selezionare quella con la corrispondenza più adatta







	L’ultima schermata, Aggiornare i conti di GnuCash, fornisce una lista di tre scelte possibili per uscire dall’assistente.
	Annulla — esce dal processo e annulla l’importazione di file QIF.
Avvertimento
Se si preme questo pulsante, qualsiasi selezione fatta fino a questo punto verrà persa.


	Indietro — fa apparire la schermata precedente in modo da poter modificare una selezione fatta in quella finestra.

	Avanti — importa i dati e crea i conti specificati.






A questo punto i conti dovrebbero essere stati importati correttamente.

Resoconti per gli affari



I resoconti per gli affari includono i rapporti su clienti e venditori, le fatture stampabili e i resoconti Aging reports.
	Resoconto cliente:

	Fattura semplice:

	Resoconto dipendente:

	Fattura elaborata:

	Payable Aging:

	Fattura stampabile:

	Receivable Aging:

	Resoconto venditore:




Capitolo 1. Introduzione a GnuCash

Cos’è GnuCash?



GnuCash è un’applicazione per la gestione delle finanze personali e di piccole attività. È progettato per essere facile da usare, ma comunque potente e flessibile. GnuCash permette di registrare le entrate e le uscite, di riconciliare i conti bancari, di monitorare le azioni e di amministrare le finanze della propria attività professionale. È basato sulle leggi fondamentali della contabilità per assicurare registrazioni in bilancio e resoconti accurati.

Stampare ed esportare resoconti e grafici



Nota
Da verificare!!! Come personalizzare la stampa con Gnome?

GnuCash è in grado di stampare i resoconti e di esportarli nel formato HTML. La finestra di stampa di un documento di GnuCash è accessibile dal pulsante Stampa sulla barra degli strumenti o tramite il menu selezionando la voce File → Stampa. Per esportare un resoconto come pagina internet (HTML), selezionare il pulsante Esporta sulla barra degli strumenti e inserire il nome da assegnare al file.
La finestra di stampa di un documento di GnuCash permette di selezionare la stampante alla quale inviare il lavoro di stampa o il file su cui stampare il documento. La finestra fornisce anche un pulsante di Anteprima per controllare il documento prima di inviarlo in stampa. Premendo Stampa il lavoro verrà inviato alla stampante selezionata mentre premendo Annulla la finestra verrà chiusa senza effettuare alcuna stampa.
Stampando dalla finestra del registro, verrà stampato il resoconto dei conti, che è anche chiamato resoconto del registro. In esso sono elencate le transazioni nel conto con un totale. Gli altri resoconti vengono invece stampati come sono visualizzati nella schermata del resoconto.

Entrate e Uscite



I resoconti per entrate e uscite includono il flusso di liquidi e i rapporti sulle entrate.
	Resoconto di bilancio

	Flusso di liquidi:

	Stato patrimoniale:

	Istogramma delle uscite:

	Grafico a torta delle uscite:

	Uscite per giorno della settimana:

	Istogramma delle entrate:

	Grafico delle entrate e delle uscite:

	Income Statement: This report summarizes sources of income and expenditure.
         (This report was called Profit & Loss in gnucash-1.8.)

	Prospetto delle entrate:

	Entrate per giorno della settimana:

	Bilancio di previsione: questo resoconto riassume le fonti di reddito e di spesa.




4. MODIFICATIONS



You may copy and distribute a Modified Version of the Document under the conditions of sections 2 and 3 above, provided that you release the Modified Version under precisely this License, with the Modified Version filling the role of the Document, thus licensing distribution and modification of the Modified Version to whoever possesses a copy of it. In addition, you must do these things in the Modified Version:
	A. Use in the Title Page (and on the covers, if any) a title distinct from that of the Document, and from those of previous versions (which should, if there were any, be listed in the History section of the Document). You may use the same title as a previous version if the original publisher of that version gives permission.

	B. List on the Title Page, as authors, one or more persons or entities responsible for authorship of the modifications in the Modified Version, together with at least five of the principal authors of the Document (all of its principal authors, if it has less than five).

	C. State on the Title Page the name of the publisher of the Modified Version, as the publisher.

	D. Preserve all the copyright notices of the Document.

	E. Add an appropriate copyright notice for your modifications adjacent to the other copyright notices.

	F. Include, immediately after the copyright notices, a license notice giving the public permission to use the Modified Version under the terms of this License, in the form shown in the Addendum below.

	G. Preserve in that license notice the full lists of  Invariant Sections and required Cover Texts given in the Document’s license notice.

	H. Include an unaltered copy of this License.

	I. Preserve the section entitled «History», and its title, and add to it an item stating at least the title, year, new authors, and publisher of the Modified Version as given on the Title Page. If there is no section entitled «History» in the Document, create one stating the title, year, authors, and publisher of the Document as given on its Title Page, then add an item describing the Modified Version as stated in the previous sentence.

	J. Preserve the network location, if any, given in the Document for public access to a Transparent copy of the Document, and likewise the network locations given in the Document for previous versions it was based on. These may be placed in the «History» section. You may omit a network location for a work that was published at least four years before the Document itself, or if the original publisher of the version it refers to gives permission.

	K. In any section entitled «Acknowledgements» or «Dedications», preserve the section’s title, and preserve in the section all the substance and tone of each of the contributor acknowledgements and/or dedications given therein.

	L. Preserve all the Invariant Sections of the Document, unaltered in their text and in their titles. Section numbers or the equivalent are not considered part of the section titles.

	M. Delete any section entitled «Endorsements». Such a section may not be included in the Modified Version.

	N. Do not retitle any existing section as «Endorsements» or to conflict in title with any Invariant Section.



If the Modified Version includes new front-matter sections or appendices that qualify as Secondary Sections and contain no material copied from the Document, you may at your option designate some or all of these sections as invariant. To do this, add their titles to the list of Invariant Sections in the Modified Version’s license notice. These titles must be distinct from any other section titles.
You may add a section entitled «Endorsements», provided it contains nothing but endorsements of your Modified Version by various parties--for example, statements of peer review or that the text has been approved by an organization as the authoritative definition of a standard.
You may add a passage of up to five words as a Front-Cover Text, and a passage of up to 25 words as a Back-Cover Text, to the end of the list of Cover Texts in the Modified Version. Only one passage of Front-Cover Text and one of Back-Cover Text may be added by (or through arrangements made by) any one entity. If the Document already includes a cover text for the same cover, previously added by you or by arrangement made by the same entity you are acting on behalf of, you may not add another; but you may replace the old one, on explicit permission from the previous publisher that added the old one.
The author(s) and publisher(s) of the Document do not by this License give permission to use their names for publicity for or to assert or imply endorsement of any Modified Version .

Creare un nuovo conto



Per creare un nuovo conto selezionare Operazioni → Nuovo conto... o fare clic sul pulsante Nuovo della barra degli strumenti quando è visualizzata la finestra della struttura dei conti. Verrà aperta la finestra per la creazione di un Nuovo conto.
La finestre di dialogo delle proprietà per un Nuovo conto consta di due schede, quella delle preferenze Generali e quella del Bilancio d’apertura. 
Creare un nuovo conto richiede la pianificazione di alcuni dettagli che dovranno essere inseriti nella finestra di dialogo per il nuovo conto.
	Il tipo di conto di cui si ha bisogno.

	Dove si deve posizionare nella struttura dei conti.

	Se è previsto un bilancio preventivo.

	Se c’è la necessità di una commodity (titolo/valuta) per il conto.

	Se si ha bisogno dell’aggiornamento online del prezzo della commodity.



Questi dettagli sono descritti nel seguito.
Scheda delle informazioni generali



La scheda Generali permette l’accesso alle informazioni di base del conto. Fornisce un modo di collegare il conto alle informazioni sulle azioni se si tratta di un tipo di conto per la valuta, per i fondi comuni o per le azioni. Qui, il conto può anche essere marcato come segnaposto; viene inoltre mostrato se il conto è identificato come relativo alle tasse (che è configurato attraverso il menu Modifica → Opzioni resoconto tasse).
Sono presenti sette riquadri nella sezione Identificazione di questa scheda.
	Nome conto: il nome per il conto (ad esempio Conto Corrente Banca).

	Codice conto: un codice del conto opzionale come descritto in Codici dei conti.

	Descrizione: una descrizione opzionale per il conto.

	Titolo/valuta: 
Nota
Il campo Tipo alla voce Seleziona titolo dipende dalla selezione fatta nel pannello Tipo di conto nella schermata Nuovo conto.

	Per i conti diversi da Azioni e Fondi comuni questa dovrebbe essere la valuta predefinita cioè EUR (Euro) o il simbolo della propria valuta locale. Se questo conto è per una valuta estera, premere il pulsante Seleziona... per scegliere una valuta differente dalla lista a comparsa delle valute.

	Per i conti contenenti azioni e fondi comuni; selezionare dapprima Azioni o Fondi comuni nel riquadro del Tipo di conto, poi il Conto padre, infine usare il pulsante Seleziona..., per scegliere il Tipo (normalmente il mercato dove il titolo viene scambiato) e il Titolo dalla finestra di Scelta del titolo.
Se il titolo o il fondo di cui si ha bisogno non compare nell’elenco ma se ne conosce il Tipo, è possibile creare il titolo o il fondo. Per creare una commodity per i fondi comuni e per le azioni, selezionare Nuovo..., nella schermata di Scelta del titolo, per aprire la schermata del Nuovo titolo:. Le opzioni presenti sono descritte in la sezione chiamata «Editor titoli». Inserire un Nome, il simbolo, selezionare il Tipo e infine premere il pulsante Chiudi per creare il titolo. Dopo che il titolo è stato creato, selezionare il Tipo: (normalmente la borsa dove il titolo viene scambiato) e il nome nella lista a comparsa Valuta/titolo: e premere Chiudi per chiudere la finestra.




	Frazione minima: la frazione minima che verrà registrata.

	Colore del conto: il colore da assegnare alla scheda del registro relativo a questo conto. Fare clic sul pulsante del colore per aprire la schermata di Selezione del colore. Per ripristinare il colore del conto fare clic sul pulsante Predefinito.

	Note: riquadro per inserire del testo liberamente; è utilizzato per qualsiasi nota aggiuntiva relativa al conto.



Sotto a questi riqaudri, sono presenti delle opzioni: una indica se il conto è Relativo alle tasse (impostabile tramite il menu Modifica → Opzioni tasse), mentre le altre due permettono di marcare il conto come Segnaposto e Nascosto.
L’opzione Relativo alle tasse permette di marcare il conto per essere incluso nelle esportazioni relative alle tasse. Questo attributo è visualizzato solamente nella schermata di Modifica conto ed è impostato nella finestra delle Informazioni tasse sulle entrate (Modifica → Opzioni resoconto tasse). Consultare la sezione sui resoconti delle tasse e sull’esportazione dei file TXF nel capitolo sui resoconti (la sezione chiamata «Resoconti generali»).
L’opzione Segnaposto indica che il conto rappresenta solamente un segnaposto nella struttura; è utilizzato solamente per permettere l’impostazione di una struttura dei conti.
Nota
L’opzione Segnaposto indica che il conto non deve essere utilizato per contenere i dati sulle transazioni. Se il conto è un segnaposto, non potrà contenere delle transazioni: le transazioni potranno essere inserite solamente negli eventuali suoi sottoconti non identificati anch’essi come Segnaposto.

L’opzione Nascosto permette di nascondere questo conto (e ogni suo sottoconto) nella struttura dei conti e di non visualizzarlo nella lista a comparsa dei conti nella finestra del registro. Per disabilitare questa opzione occorre andare in Visualizza → Filtra per... nella finestra della struttura dei conti, e abilitare l’opzione Visualizza i conti nascosti. In questo modo sarà possibile selezionare il conto e riaprire questa finestra.
Il riquadro seguente contiene una elenco di Tipi di conto. Selezionarne uno in base alla descrizione fornita in la sezione chiamata «Tipi di conti in GnuCash».
Il riquadro successivo contiene un albero dei conti dal quale scegliere il Conto padre. Per creare un nuovo albero dei conti, selezionare Nuovo conto di livello principale. 
Nota
Le scelte disponibili nel riquadro del Tipo di conto dipendono dalla selezione effettuata nel riquadro del Conto padre. Per esempio se il Conto padre  è Capitali verrà mostrato solamente il Tipo di conto Capitale. Questo permette di mantenere una struttura dei conti coerente.

Procedura per abilitare l’aggiornamento dei prezzi online



	GnuCash si affida a uno strumento esterno per recuperare le quotazioni via internet. Questo strumento è un modulo di Perl denominato Finance::Quote e deve essere installato sul proprio computer indipendentemente da GnuCash. Il primo passo per abilitare l’aggiornamento delle quotazioni tramite internet consiste nell’assicurarsi che Finance::Quote sia installato correttamente.
Per sapere se il modulo di Perl Finance::Quote è già installato nel sistema, digitare «perldoc Finance::Quote» in una finestra del terminale e verificare se c’è qualche documentazione disponibile. Se c’è la documentazione allora il modulo è installato, altrimenti no.
L’installazione di Finance::Quote differisce a seconda del sistema operativo in uso. Per i vari sistemi supportati, è possibile seguire le seguenti linee guida:
	Linux: la maggior parte delle distribuzioni (Fedora, openSuse, Mandriva, Ubuntu, ecc... ) forniscono un pacchetto nei propri repository per il modulo di perl Finance::Quote. Quindi nella maggior parte dei casi è sufficiente utilizzare il proprio gestore di pacchetti preferito (yum, apt, rpm, synaptics, yast, ecc...)  per installare il modulo. Il nome del pacchetto può variare da distribuzione a distribuzione. In genere ha un nome del tipo «perl-Finance-Quote».

	Windows: Finance::Quote su windows richiede che sia già installato perl. Se non lo è, è prima necessario installare ActivePerl.
Il file installabile di GnuCash disponibile sulla pagina principale, contiene un piccolo programma che assiste nell’installazione di Finance::Quote. È possibile raggiungerlo dal menu «Start» nel gruppo GnuCash ed è chiamato «Installa la funzione di ricerca delle quotazioni online».

	Mac OS X: se GnuCash è stato installato dal pacchetto di installazione disponibile sulla pagina principale di GnuCash, Finance::Quote è già installato.

	Se nessuno dei precedenti casi è adatto alla propria situazione, è possibile seguire le seguenti istruzioni più generali:
	Chiude ogni sessione di GnuCash aperta.

	Trovare la cartella dove è installato GnuCash cercando la stringa «gnc-fq-update» (senza le virgolette).

	Spostarsi in questa cartella, aprire una finestra del terminale ed eseguire come root il comando «gnc-fq-update» (senza le virgolette). Si aprirà una sessione di aggiornamento di Perl CPAN che installerà nel sistema, attraverso internet, il modulo Finance::Quote. Il programma gnc-fq-update è interattivo, comunque, con la maggior parte dei sistemi, si potrà rispondere «no» alla prima domanda: «Eseguire la configurazione manuale? [sì]» e l’aggiornamento continuerà automaticamente da questo punto.






Quando l’installazione è terminata, eseguire il programma di test «gnc-fq-dump», nella stessa cartella, distribuito con GnuCash per verificare se Finance::Quote è installato e funziona correttamente.
Nota
Se non ci si sente sicuri nell’esecuzione di questi passaggi, è possibile contattare la lista di discussione degli utenti di GnuCash (<gnucash-user@gnucash.org>) per chiedere aiuto o andare nell canale IRC di GnuCash su irc.gnome.org. È anche possibile saltare questi passaggi e aggiornare manualmente i prezzi delle proprie azioni.


	Creare il conto per il fondo comune o per le azioni impostando il campo titolo/valuta, come descritto nel seguito.
Suggerimento
Quando si creano questi tipi di conti, si consiglia di creare anche dei conti delle entrate per registrare i dividendi, i guadagni in capitale (nel lungo e nel breve periodo) e i conti per le uscite per registrare le commissioni e le perdite ( se si considerano le perdite come uscite).


	Si creino il fondo comune o le azioni sia utilizzando l’editor titoli per le azioni o i fondi esistenti, o la finestra del nuovo titolo perle nuove azioni o fondi.
Selezionare l’opzione Ricevi quotazioni online, il tipo di fonte per le quote e il Fuso orario.
Per la ricezione delle quotazioni via internet, è necessario avere abilitato le opzioni per la ricezione delle quote online e il fuso orario.
	Ricevi quotazioni online - questa opzione permette di abilitare lo specifico titolo o azioni alla ricezione delle quotazioni da una fonte online.

	Tipo di fonte per le quote: selezionare, fra le tre opzioni disponibili, il tipo di fonte da cui ricevere le quotazioni. Le fonti Multi-riga quali «Europe» possono essere usate per superare i problemi di connessione con un unica fonte. Scegliendo invece Singola, verranno ricercate informazioni solo dalla fonte specificata.
Dopo aver selezionato il tipo di fonte per le quotazioni, selezionare un elemento della relativa lista a a comparsa. Attualmente fra le fonti disponibili e supportate, si ricordano: Yahoo, Yahoo Europe, Fidelity Investments, T. Rowe Price, the Vanguard Group, the Australian Stock Exchange (ASX) e TIAA-CREF.
Nota
Si noti che Yahoo fornirà le quotazioni per diversi fondi comuni compresi Fidelity, T.Rowe Price e Vanguard, e che i prezzi indicati da Yahoo dovrebbero essere identici a quelli che è possibile reperire nei siti di origine.

Se si sceglie Yahoo Europe o Europe, è necessario indicare il codice della borsa per il titolo, come, per esempio, PA per Parigi, BE per Berlino ecc... Esempio: 12150.PA (un titolo Peugeot sul mercato di Parigi). Tabella A.1, «Lista dei codici delle borse per i mercati Europei» elenca i codici per i vari mercati Europei.
Pseudo-simboli per i fondi TIAA-CREF sono elencati nella tabella Tabella A.2, «Pseudo simboli da utilizzare per le quotazioni TIAA-CREF».

	Fuso orario - selezionare il fuso orario per la quota che si desidera ricevere. Per esempio, Yahoo fornisce le quotazioni con il fuso orario della costa orientale degli Stati Uniti, quindi occorre scegliere America/New York se si utilizza questa fonte per le quotazioni.




	Selezionare una commodity nell’editor dei prezzi.

	Selezionare Ricevi quotazioni nella finestra di modifica prezzo.

	Controllare l’ultimo prezzo per il titolo selezionato.



Per aggiornare le quotazioni dalla linea di comando, eseguire il comando seguente:
gnucash --add-price-quotes <nome-de-file-di-gnucash>
          
Il comando gnucash --add-price-quotes <gnucash-file-name> può essere utilizzato per ottenere il prezzo corrente delle proprie azioni. Il file specificato «<gnucash-file-name>» dipenderà dal nome e dalla posizione del proprio file dei dati. Questo può essere individuato dal nome visualizzato nella cornice in alto nella finestra di GnuCash prima del «-». Il nome del file può anche essere trovato nel menu File nell’elenco dei file recentemente aperti; il primo elemento, numerato 1, è il nome del file attualmente aperto.
Questa procedure può essere automatizzata creando un comando di crontab. Per esempio, per aggiornare il proprio file Venerdì sera (alle 18:00) dopo la chiusura della borsa (l’orario può essere diverso a seconda del fuso), è possibile aggiungere il comando seguente alla lista del crontab:
0 18 * * 5 gnucash --add-price-quotes $HOME/gnucash-filename > /dev/null 2>e1
Si ricordi che i «prezzi» dei fondi comuni rappresentano dei «valori di capitale netto (NAV)» e richiedono diverse ore dopo la chiusura dei mercati per essere disponibili. Se i NAV vengono scaricati prima del giorno in cui vengono determinati, si riceveranno i valori del giorno precedente.


Scheda del bilancio di apertura



La scheda del bilancio di apertura è visibile solo quando si crea un nuovo conto. Il bilancio di apertura è utilizzato per registrare il saldo iniziale di un conto. Questo permette di utilizzarlo in due differenti situazioni. Se si usa GnuCash per la prima volta per registrare delle transazioni, può essere usato come saldo iniziale. Se i conti sono chiusi alla fine di un periodo e dei nuovi conti sono creati, è utilizzato per chiudere e trasferire i saldi in avanti.
In questa scheda sono presenti tre riquadri. Quello superiore contiene le Informazioni sul saldo.
	Saldo: immettere il saldo con cui inizializzare il conto.

	Data: la data con cui il bilancio di apertura deve essere registrato.



Il riquadro successivo è quello del Tipo di trasferimento.
	Utilizza il conto del capitale per i bilanci di apertura: in questo modo si trasferisce il bilancio di apertura per il conto da un conto standard del capitale chiamato bilanci di apertura.

	Selezionare il conto di trasferimento: questa opzione abilita il riquadro inferiore in modo che un conto differente possa essere utilizzato per trasferire il bilancio di apertura.



L’ultimo riquadro è quello del Conto di trasferimento. Selezionare il conto da utilizzare per il bilancio d’apertura scegliendo fra quelli della lista nel riquadro.


Editor prezzi



L’editor prezzi è utile per modificare o registrare il valore di una valuta, di un fondo comune o di una azione. Esso fornisce un’unica interfaccia per aggiornare i valori di queste commodity ed è in grado di aggiornarle sia attraverso la ricezione di quotazioni via internet oppure manualmente.
Ogni elemento nell’editor rappresenta una registrazione del prezzo di una commodity o titolo:
	Titolo:  la commodity o il titolo di cui recuperare il prezzo. La visualizzazione è ordinata per mercato in cui i singoli titoli sono scambiati. L’elenco può essere espanso facendo clic sul simbolo a sinistra del nome.

	Valuta: la valuta con cui il prezzo è registrato.

	Data: la data in cui il prezzo è stato registrato.

	Fonte: la fonte del prezzo per la commodity. Generalmente, questa sarà o user:price-editor, a indicare che è stata immessa direttamente dall’utente, o Finance::Quote, a indicare che è stata ricevuta da una fonte online con il modulo Finance::Quote.

	Tipo: esistono diversi tipi di prezzi per le azioni.
	Offerta: indica il prezzo con cui un operatore specializzato è pronto ad acquistare un’azione.

	Domanda:  indica il prezzo con cui gli operatori sono pronti a vendere l’azione.

	Ultimo:  indica il prezzo con cui è avvenuto l’ultimo scambio per l’azione o titolo. Rappresenta il prezzo più comunemente utilizzato dai media.

	Valore netto delle attività: è tipicamente utilizzato per i fondi comuni. Sono generalmente calcolate sul valore netto dell’attività del fondo.

	Sconosciuto: utilizzare questa voce se il tipo di prezzo non è noto.




	Prezzo: il prezzo attuale della commodity.



Aggiungere manualmente il prezzo di un’azione



Per inserire un nuovo prezzo, premere Aggiungi e inserire i dettagli del titolo e del prezzo nel riquadro. Per modificare un prezzo esistente, selezionarlo dalla lista dei prezzi, premere il pulsante Modifica e modificare i dati presenti.
Per cancellare un singolo prezzo, selezionarlo e premere il pulsante Rimuovi. Per rimuovere tutti i prezzi più vecchi di una certa data, premere il pulsante Rimuovi vecchi e inserire i dettagli nella schermata visualizzata.
Verrà visualizzata una finestra con il messaggio "Cancella tutti i prezzi delle azioni in base al seguente criterio:". Inserire quindi la data dell’ultimo prezzo da cancellare.
Al di sotto del campo della data sono presenti due opzioni:
	Cancella i prezzi inseriti manualmente - se selezionata, verranno cancellati i prezzi immessi manualmente e datati precedentemente alla data specificata. Diversamente solo i prezzi aggiunti dal modulo Finance::Quote verranno cancellati.

	Cancella l’ultimo prezzo per un’azione - se selezionata, verranno cancellati i prezzi precedenti alla data specificata. Diversamente, l’ultimo prezzo precedente alla data specificata verrà conservato e tutte le quote più vecchie saranno cancellate.




Configurazione per l’utilizzo del pulsante Ricevi quotazioni



Per avere il supporto alla ricezione delle quotazioni tramite internet per una particolare azione o fondo comune, occorre prima di tutto abilitare l’opzione per la ricezione delle quotazioni e selezionare una fonte nell’Editor titolo. Questo processo è descritto in dettaglio in la sezione chiamata «Configurare titoli e valute per la ricezione online dei prezzi». Una volta abilitato il servizio e installato il modulo Finance::Quote, sarà possibile aggiornare le quotazioni delle proprie azioni e dei propri fondi comuni premendo semplicemente il pulsante Ricevi quotazioni.


5. COMBINING DOCUMENTS



You may combine the Document with other documents released under this License, under the terms defined in section 4 above for modified versions, provided that you include in the combination all of the Invariant Sections of all of the original documents, unmodified, and list them all as Invariant Sections of your combined work in its license notice.
The combined work need only contain one copy of this License, and multiple identical Invariant Sections may be replaced with a single copy. If there are multiple Invariant Sections with the same name but different contents, make the title of each such section unique by adding at the end of it, in parentheses, the name of the original author or publisher of that section if known, or else a unique number. Make the same adjustment to the section titles in the list of Invariant Sections in the license notice of the combined work.
In the combination, you must combine any sections entitled «History» in the various original documents, forming one section entitled «History»; likewise combine any sections entitled «Acknowledgements», and any sections entitled «Dedications». You must delete all sections entitled «Endorsements.»

Libro mastro generale



Il libro mastro generale è un registro avanzato che permette di inserire le transazioni senza il bisogno di aprire i singoli conti; permette anche di visualizzare tutte le transazioni per tutti i conti in un unico registro.
L’inserimento di una transazione nel libro mastro generale è più complicato rispetto alla stessa operazione compiuta dal registro del conto. Il vantaggio del libro mastro generale risiede nella visualizzazione più esaustiva delle transazioni inserite in tutti i propri conti.
Il libro mastro generale è impostato di default per visualizzare solamente le transazioni dell’ultimo mese. Questa impostazione può essere cambiata utilizzando la voce «Intervallo temporale» nel menu «Visualizza».

Creare una struttura dei conti



La struttura dei conti è come una indice delle proprie finanze. Il miglior modo per concettualizzare una struttura dei conti è di pensarla come un albero. I rami principali rappresentano intere categorie o gruppi, mentre le foglie dell’albero rappresentano conti bancari o categorie di uscite. Quando viene richiesto un resoconto sommario, tipicamente solo i rami principali vengono riportati, invece che i conti individualmente. Per esempio, una struttura dei conti potrebbe assomigliare alla seguente:


300 Uscite | +--310 Bollette | | | +--311 Birra | | | +--312 Abbonamento TV | +--320 Uscite di lavoro | | | +--321 Dichetti | | | +--322 Dischi Blue Ray | | : :



Codici dei conti
I conti non hanno solo dei nomi; possono avere anche dei codici, per essere ordinati. Quando viene generato un resoconto, l’ordinamento è determinato dalla numerazione. È consuetudine che i numeri dei sottoconti non terminino con zero, mentre i conti padre abbiano numeri crescenti dallo zero.

Avvertimento
GnuCash non impedisce che vengano utilizzati dei numeri duplicati, comunque se ne scoraggia l’utilizzo. I codici dei conti sono trattati come numeri in base 36, quindi, se si terminano i numeri, è possibile utilizzare le lettere dalla a alla z.


Saltare al registro di un altro conto



Quando si utilizza la finestra del registro del conto, può rivelarsi utile essere in grado di vedere un altro conto e il conto di trasferimento allo stesso tempo. GnuCash permette di eseguire velocemente questa operazione utilizzando la funzione di «salto»; è infatti disponibile, nella barra degli strumenti, il pulsante Salta raggiungibile anche tramite il menu Operazioni → Salta nella finestra del registro del conto.
Selezionare la transazione nella finestra del registro del conto e premere il pulsante Salta oppure selezionare Operazioni → Salta per aprire la finestra del registro del conto di destinazione. Se la transazione è suddivisa in più di un conto allora sarà necessario visualizzare tutti i conti di suddivisione e selezionare quello in cui si desidera "saltare".

1. APPLICABILITY AND DEFINITIONS



This License applies to any manual or other work that contains a notice placed by the copyright holder saying it can be distributed under the terms of this License. The «Document», below, refers to any such manual or work. Any member of the public is a licensee, and is addressed as «you».
A «Modified Version» of the Document means any work containing the Document or a portion of it, either copied verbatim, or with modifications and/or translated into another language.
A «Secondary Section» is a named appendix or a front-matter section of the Document that deals exclusively with the relationship of the publishers or authors of the Document to the Document’s overall subject (or to related matters) and contains nothing that could fall directly within that overall subject. (For example, if the Document is in part a textbook of mathematics, a Secondary Section may not explain any mathematics.) The relationship could be a matter of historical connection with the subject or with related matters, or of legal, commercial, philosophical, ethical or political position regarding them.
The «Invariant Sections» are certain  Secondary Sections whose titles are designated, as being those of Invariant Sections, in the notice that says that the Document is released under this License.
The «Cover Texts» are certain short passages of text that are listed, as Front-Cover Texts or Back-Cover Texts, in the notice that says that the Document is released under this License.
A «Transparent» copy of the  Document means a machine-readable copy, represented in a format whose specification is available to the general public, whose contents can be viewed and edited directly and straightforwardly with generic text editors or (for images composed of pixels) generic paint programs or (for drawings) some widely available drawing editor, and that is suitable for input to text formatters or for automatic translation to a variety of formats suitable for input to text formatters. A copy made in an otherwise Transparent file format whose markup has been designed to thwart or discourage subsequent modification by readers is not Transparent. A copy that is not «Transparent» is called «Opaque».
Examples of suitable formats for Transparent copies include plain ASCII without markup, Texinfo input format, LaTeX input format, SGML or XML using a publicly available DTD, and standard-conforming simple HTML designed for human modification. Opaque formats include PostScript, PDF, proprietary formats that can be read and edited only by proprietary word processors, SGML or XML for which the DTD and/or processing tools are not generally available, and the machine-generated HTML produced by some word processors for output purposes only.
The «Title Page» means, for a printed book, the title page itself, plus such following pages as are needed to hold, legibly, the material this License requires to appear in the title page. For works in formats which do not have any title page as such, «Title Page» means the text near the most prominent appearance of the work’s title, preceding the beginning of the body of the text.

8. TRANSLATION



Translation is considered a kind of modification, so you may distribute translations of the Document under the terms of section 4. Replacing  Invariant Sections with translations requires special permission from their copyright holders, but you may include translations of some or all Invariant Sections in addition to the original versions of these Invariant Sections. You may include a translation of this License provided that you also include the original English version of this License. In case of a disagreement between the translation and the original English version of this License, the original English version will prevail.

Capitolo 6. Operazioni comuni per le transazioni



Una transazione rappresenta un movimento di denaro da un conto ad un altro. Ogni volta che si spende o si riceve del denaro, oppure si trasferisce denaro da un conto ad un altro, si parla di transazione. In GnuCash queste operazioni coinvolgono sempre almeno due conti.
GnuCash utilizza i conti come metodo per raggruppare ed organizzare la registrazione delle transazioni. Questa sezione descrive i metodi che GnuCash fornisce per aiutare ad inserire velocemente nel registro le transazioni.

GnuCash permette di inserire le transazioni in diversi modi.
	Immettere le transazioni direttamente dalla finestra del registro rappresenta il metodo più immediato.

	Utilizzando la finestra del trasferimento fondi.

	Importando le transazioni o da un file QIF/OFX o attraverso "OFX online banking".



Cambiare la visualizzazione del registro



GnuCash fornisce diverse opzioni per cambiare il modo in cui viene visualizzato il registro permettendo di mostrare con più chiarezza le transazioni. Lo stile predefinito è quello a "libro mastro basilare": con questa modalità viene mostrata una singola linea per ogni transazione e si tratta del metodo più sintetico per la visualizzazione dei dettagli più rilevanti.
Lo stile di visualizzazione predefinito può essere cambiato dal menu Visualizza: qui sono possibili tre scelte. Quando al finestra del registro viene chiusa, lo stile tornerà a essere quello del libro mastro basilare. Per rendere il cambiamento permanente occorre cambiare lo stile nella scheda Predefinite del registro delle Preferenze di GnuCash.
	Libro mastro basilare: lo stile predefinito costituito da una riga per transazione. Le suddivisioni sono mostrate come sommario. Il pulsante Suddivisione e lavoce del menu Operazioni → Suddividi transazione sono abilitati.

	Mastro ad espansione automatica: questo stile espande automaticamente la transazione selezionata se contiene delle suddivisioni.

	Giornale della transazione: questo stile espande tutte le transazioni in modo da poterle visualizzare completamente.

	Doppia linea: questa opzione agisce sugli stili appena descritta visualizzando una riga aggiuntiva per le note della transazione.



Le altre due opzioni per cambiare la visualizzazione del registro sono: Visualizza → Filtra per... per restringere il numero di elementi visualizzati, e Visualizza → Ordina per.... la sezione chiamata «Registro del conto - Menu Visualizza».


Finestra della transazione pianificata



Per semplificarne la consultazione, si riporta l’elenco degli argomenti affrontati in questa sezione: la sezione chiamata «Menu Pianifica», la sezione chiamata «Pulsanti della Barra degli strumenti per la finestra delle Transazioni pianificate», la sezione chiamata «Finestra della transazione pianificata». la sezione chiamata «Finestra di modifica della transazione pianificata»,
La descrizione dettagliata di cosa si intende per transazione pianificata, è fornita in la sezione chiamata «Pianificare le transazioni».
Finestra principale delle transazioni pianificate



Questa finestra è mostrata quando si seleziona la voce Operazioni → Transazioni pianificate → Editor transazioni pianificate dalla barra del menu. Verrà aperta una finestra che visualizzerà la transazione pianificata.
Componenti principali della finestra per le transazioni pianificate




Tabella 4.27. Componenti della finestra per le transazioni pianificate.
	Componenti
	Descrizione

	Barra del menu
	Contiene il menu utilizzato nella finestra della transazioni pianificate. Fornisce la lista standard delle opzioni della barra del menu e in più la voce Pianifica, che contiene i comandi Nuovo, Modifica e Cancella. Se non è selezionata alcuna transazione, le voci Modifica e Cancella non saranno selezionabili.

	Barra degli strumenti (icone e/o testo)
	Contiene dei pulsanti utilizzabili per accedere alle operazioni relative alle transazioni pianificate.

	Schede
	Permettono di muoversi tra le schermate aperte.

	Transazioni
	Il riquadro Transazioni contiene un elenco di transazioni pianificate e delle relative caratteristiche.

	Prossime scadenze
	Il riquadro delle Prossime scadenze contiene un calendario dei mesi successivi. In questo calendario sono evidenziati i giorni in cui sono pianificate una o più transazioni.

                È possibile modificare l’intervallo di date visualizzato nel calendario selezionando un periodo diverso dalla lista a comparsa Visualizza sulla destra.

                Suggerimento
Fare clic con il mouse nel riquadro e verranno visualizzati i dettagli relativi alle transazioni pianificate per la data selezionata.


                





Menu Pianifica



La tabella seguente descrive le opzioni del menu Pianifica disponibile nella Barr del menu all’interno della finestra delle Transazioni pianificate.
Tabella 4.28. Menu Pianifica - permette di accedere alle operazioni di modifica della transazione pianificata.
	Voce del menu
	Descrizione

	Nuovo
	Aggiunge una nuova transazione pianificata.

	Modifica
	Modifica la transazione selezionata.

	Cancella
	Rimuove la transazione selezionata.






Pulsanti della Barra degli strumenti per la finestra delle Transazioni pianificate



La finestra per le Transazioni pianificate presenta una barra degli strumenti utile per accedere velocemente alle funzioni più comunemente utilizzate per la pianificazione.
Tabella 4.29. Barra degli strumenti della finestra Transazioni pianificate
	Pulsante della Barra degli strumenti
	Descrizione

	
                  Salva (Ctrl+S)
                
	Modifica la transazione selezionata.

	
                  Chiudi (Ctrl+W)
                
	Chiude la finestra delle Transazioni pianificate.

	Nuovo
	Salva la pianificazione della transazione selezionata.

	Modifica
	Modifica la transazione selezionata.

	Cancella
	Rimuove la transazione selezionata.








7. AGGREGATION WITH INDEPENDENT WORKS



A compilation of the Document or its derivatives with other separate and independent documents or works, in or on a volume of a storage or distribution medium, does not as a whole count as a Modified Version of the Document, provided no compilation copyright is claimed for the compilation. Such a compilation is called an «aggregate», and this License does not apply to the other self-contained works thus compiled with the Document , on account of their being thus compiled, if they are not themselves derivative works of the Document. If the Cover Text requirement of section 3 is applicable to these copies of the Document, then if the Document is less than one quarter of the entire aggregate, the Document’s Cover Texts may be placed on covers that surround only the Document within the aggregate. Otherwise they must appear on covers around the whole aggregate.

Operazioni online...



Nota
Questa sezione è "in costruzione - ogni contributo è benvenuto!!".

Ricevi saldo





Ricevi transazioni ...





Inoltra transazione





Addebito diretto






Rinumerare i sottoconti



Utilizzare Rinumera sottoconti per riassegnare i codici dei conti per tutti i figli del conto padre corrente. Per esempio, se si ha la seguente struttura dei conti:
Tabella 5.2. Numeri iniziali dei conti.
	Codice
	Nome

	10
	Colori

	10-1
	Rosso

	10-2
	Arancione

	10-3
	Giallo

	10-4
	Blu

	10-5
	Viola





Si voglia ora aggiungere il conto «Verde», ma si voglia anche inserirlo tra i conti «Giallo» e «Blu». Invece di dover rinumerare tutti i conti manualmente a partire dal «Blu», si può usare il comando Rinumera sottoconti per il conto «Colori». Nella finestra che comparirà il valore della voce prefisso dovrebbe essere già impostata a «10», il codice del conto «Colori». Se si imposta un valore dell’intervallo pari a «5» e si preme Rinumera, si otterrà la seguente struttura:
Tabella 5.3. Numeri dei conti rinumerati
	Codice
	Nome

	10
	Colori

	10-05
	Rosso

	10-10
	Arancione

	10-15
	Giallo

	10-20
	Blu

	10-25
	Viola





Ora è disponibile lo spazio necessario nella numerazione dei conti per aggiungere il conto Verde con un codice adatto per inserirlo dove si desidera.
Tabella 5.4. Numeri finali dei conti.
	Codice
	Nome

	10
	Colori

	10-05
	Rosso

	10-10
	Arancione

	10-15
	Giallo

	10-18
	Verde

	10-20
	Blu

	10-25
	Viola






Modificare una struttura dei conti



Le modifiche alla struttura dei conti possono essere effettuate direttamente dal riquadro del Conto padre presente nella finestra di Modifica conto. È possibile spostare un conto in qualsiasi parte della struttura. Si raccomanda comunque di mantenere i conti raggruppati a seconda del tipo come descritto in la sezione chiamata «Tipi di conti in GnuCash»; questo aiuta a preservare lo schema della struttura dei conti..
Per spostare il conto selezionato in un differente conto padre è sufficiente selezionare il conto nel riquadro del Conto padre. Se viene selezionato Nuovo conto di livello principale allora il conto verrà spostato al livello principale.

Capitolo 9. Personalizzare GnuCash



Opzioni di visualizzazione del conto



Il comando Filtra per è utilizzato per impostare o modificare la vista della finestra della struttura ad albero dei conti. La scheda dei Conti permette di selezionare la tipologia dei conti che devono essere mostrati. Queste impostazioni influenzano distintamente ogni finestra aperta della struttura dei conti.
La scheda Altro permette invece di abilitare o disabilitare due opzioni: se visualizzare i conti nascosti e se mostrare i conti che hanno un totale nullo.
La finestra della struttura dei conti, mostra di default solamente la quantità di ogni commodity che si possiede, nella colonna del Totale. Spesso, però, può essere utile visualizzare altri valori; per fare questo si può premere il pulsante Opzioni nella barra del titolo (la piccola freccia verso il basso sul lato destro della barra del titolo nella finestra principale dei conti) e selezionare le voci da visualizzare. Queste scelte influenzano tutte le finestre aperte della struttura dei conti.


La scheda dei conti



Figura 4.2. Una visualizzazione della struttura ad albero dei conti.
[image: Schermata della struttura ad albero dei conti]Questa è un’immagine della scheda Conti.






Struttura dei conti - Menu



La barra del menu per la finestra della struttura dei conti contiene le seguenti opzioni:
Struttura dei conti - Menu File



La tabella seguente descrive le opzioni del menu File.
Premendo l’opzione File sulla barra del menu, comparirà un menu «a discesa» contenente le opzioni descritte in Tabella 4.1, «Struttura dei conti - Menu File - Permette l’accesso ai file, alle operazioni sui conti e alla stampa.».
Tabella 4.1. Struttura dei conti - Menu File - Permette l’accesso ai file, alle operazioni sui conti e alla stampa.
	Voce del menu
	Descrizione
	
                  Nuovo file (Ctrl+N)
                
	
                  Crea un nuovo file dei dati (per iniziare con dei nuovi conti e dei nuovi dati)

	
                  Apri... (Ctrl+O)
                
	
                  Apre un file dei dati di GnuCash già esistente.

	Importa → 
	
                  Apre il menu secondario che permette l’importazione dei file creati con altri programmi finanziari.

	 	
                  Importa QIF...
	
                  Avvia il processo di importazione di file QIF.

	 	
                  Importa OFX/QFX...
	
                  Avvia il processo di importazione di file OFX/QFX.

	 	
                  Importa file CSV o a larghezza fissa...
	
                  Avvia il processo di importazione di file CSV o a larghezza fissa.

	 	
                  Ripeti file log di GnuCash...
	
                  Avvia la ripetizione di un file di log di GnuCash. Utilie per recuperare i dati dopo un crash del programma.

	 	
                  Importa MT940
	
                  .

	 	
                  Importa MT942
	
                  .

	 	
                  Importa DTAUS
	
                  .

	 	
                  Importa DTAUS e invia
	
                  .

	
                  Salva (Ctrl+S)
                
	
                  Salva il file attualmente aperto.

	
                  Salva come... (Maiusc+Ctrl+S)
                
	
                  Salva il file attualmente aperto con un altro nome.

                    Avvertimento
NON salvare i file dei dati in ~/.gnucash/books.


                
	
                  Imposta pagina... (Maiusc+Ctrl+P)
                
	
                  Permette di selezionare la dimensione del foglio, la disposizione e i margini per la stampa.

                
	Apre il menu secondario con le voci relative all’esportazione dei conti. → 
	
                  Apre il menu per l’esportazione.

	 	
                  Esporta conti
	
                  Esporta la struttura dei conti in un nuovo file. I dati non vengono esportati.

	
                  Proprietà (Alt+Inserisci)
                
	
                  Impostazione delle opzioni per il file di GnuCash corrente.

	File aperti di recente
	
                  Lista numerata dei file aperti più di recente daGnuCash.

	
                  Esci (Ctrl+Q)
                
	
                  Esce da GnuCash.






Struttura dei conti - Menu Modifica



Tabella 4.2. Struttura dei conti - Menu Modifica - Accede alle operazioni e alle preferenze dei conti e dei dati.
	Voce del menu
	
                  Descrizione

	
                  Modifica conto (Ctrl+E)
                
	
                  Modifica il nome e le caratteristiche del conto selezionato. la sezione chiamata «Modificare un conto»

                
	
                  Cancella conto... (Cancella)
                
	
                  Rimuove un conto. Consultare la la sezione chiamata «Cancellare un conto»

	Rinumera sottoconti...
	
                 Avvia l’assistente per la rinumerazione dei conti. Consultare la sezione chiamata «Rinumerare i sottoconti».

                  Nota
Questa voce è disponibile solo se è stato selezionato un conto che possiede almeno un sotto-conto.


	Apri conto
	
                 Apre la finestra del registro per il conto selezionato.

	Apri sottoconti
	
                 Apre una finestra del registro che visualizza tutte le transazioni per il conto selezionato e per tutti i suoi sottoconti.

	
                  Trova... (Ctrl+F)
                
	
                  Permette di impostare i criteri di ricerca per una specifica transazione. Consultare la la sezione chiamata «Trovare le transazioni» per maggiori dettagli sulla funzione di ricerca.

	Preferenze (GnuCash → Preferenze su Mac OS X).
	
                  Personalizzazione di GnuCash per quanto riguarda la posizione, lo stile e tante altre opzioni. Consultare la sezione chiamata «Impostare le preferenze».

	Fogli di stile
	
                  Permette di modificare e personalizzare i fogli di stile. Vedere la la sezione chiamata «Modificare i fogli di stile».

	Opzioni resoconto tasse
	
                  Imposta le caratteristiche delle tasse per uno o più conti (solo per Stati Uniti).

                





Struttura dei conti - Menu Visualizza



Tabella 4.3. Struttura dei conti - Menu Visualizza - modifica la vista della finestra.
	Voce del menu
	Descrizione

	Barra degli strumenti
	Selezione per abilitare o disabilitare la visualizzazione della barra degli strumenti.

	Barra di riepilogo
	Selezione per abilitare o disabilitare la visualizzazione della barra di riepilogo.

	Barra di stato
	Selezione per abilitare o disabilitare la visualizzazione della barra di stato.

	Filtra per...
	Imposta il filtro per i conti visualizzati nella finestra della struttura dei conti.

	
                  Aggiorna (Ctrl+R)
                
	Ridisegna la schermata visualizzata.

	Nuova pagina dei conti
	Apre una nuova scheda in cui è visualizzata la struttura dei conti.






Struttura dei conti - Menu Operazioni



Tabella 4.4. Struttura dei conti - Menu Operazioni - Permette di impostare le transazioni pianificate, di riparare i conti, di effettuare dei frazionamenti azionari, di trasferire del denaro e di riconciliare le transazioni.
	Voce del menu
	Descrizione
	Operazioni online → 
	Questa voce del menu è mostrata solamente se è abilitato l’Online Banking GnuCash
	 	
                  Ricevi saldo
	
                  

	 	
                  Ricevi transazioni
	
                  Scarica le transazioni dai conti online

	 	
                  Inoltra transazione...
	
                  Invia una o più transazioni a un conto online

	 	
                  Transazione interna...
	
                  

	 	
                  Addebito diretto...
	
                  

	Transazioni pianificate → 
	menu secondari della voce «transazioni pianificate»
	 	
                  Editor transazioni pianificate
	
                  Richiama lo strumento di modifica di una transazione pianificata. Vedere la la sezione chiamata «Finestra di modifica della transazione pianificata»

	 	
                  Dall’ultimo avvio
	
                  Mostra le transazioni pianificate dall’ultimo avvio di GnuCash. la sezione chiamata «Assistente dall’ultimo avvio»

	 	
                  Rimborso di mutui e ipoteche...
	
                  Avvia l’assistente di rimborso di mutui e ipoteche per impostare le rate. la sezione chiamata «Assistente per mutui e ipoteche»

                
	Bilancio → 
	Menu secondario per l’impresa
	 	
                  Nuovo bilancio preventivo
	
                  Apre la finestra per la creazione di un nuovo bilancio preventivo.

	 	
                  Apri bilancio preventivo
	
                  Apre un bilancio esistente.

	Nuovo conto...	
                  Crea un nuovo conto e apre la finestra delle proprietà del conto.

	Nuova struttura conti...	
                  Avvia l’assistente per la creazione di una Nuova struttura conti.

	
                  Trasferimenti... (Ctrl+T)
                
	
                  Avvia la procedura di trasferimento tra conti.

	Riconcilia...
	
                  Avvia la procedura di riconciliazione. la sezione chiamata «Finestra delle informazioni di riconciliazione»

	Frazionamento azionario...
	
                  Avvia l’assistente per il frazionamento azionario. Ulteriori dettagli nella la sezione chiamata «Registrare un frazionamento azionario».

	Visualizza lotti...
	
                  Apre la schermata dei lotti nel conto.

	Liquidazione automatica...
	
                  Apre la schermata di liquidazione automatica dove è possibile inserire le informazioni per la liquidazione automatica.

	
                Controlla e ripara → 
	
                  Menu secondari della voce Controlla e ripara

	 	
                  Controlla e ripara conto
	
                  Ricerca e ripara le transazioni non in bilancio e le suddivisioni orfane nel conto selezionato.

	 	
                  Controlla e ripara sottoconti
	
                  Ricerca e ripara le transazioni non in bilancio e le suddivisioni orfane nel conto selezionato e nei suoi sottoconti.

	 	
                  Controlla e ripara tutti
	
                  Ricerca e ripara le transazioni non in bilancio e le suddivisioni orfane in tutti i conti.

	Ripristina avvisi...
	
                  GnuCash visualizza degli avvisi quando si cerca di effettuare determinate operazioni, come rimuovere una transazione o le suddivisioni da una transazione. La finestra di avviso presenta l’opzione di non visualizzare più questi messaggi alla ripetizione dell’operazione. Le opzioni Ricordalo e non chiedermelo di nuovo e Ricordalo e non chiedermelo di nuovo in questa sessione, permettono di disabilitarli. L’opzione Ripristina avvisi permette di ripristinare gli avvisi predefiniti, cioè abilita la visualizzazione dei messaggi.
  
                
	Rinomina pagina
	
                  Apre la casella per rinominare la scheda o la pagina corrente.






Struttura dei conti - Menu Impresa



Tabella 4.5. Struttura dei conti - Menu Impresa - permette l’accesso alle funzioni di GnuCash dedicate all’impresa.
	Voce del menu
	
                  Descrizione

	Cliente → 
	
                  Seleziona le operazioni relative al cliente.

	 	
                  Nuovo cliente...
	
                  Avvia la scheda per la creazione di un nuovo cliente.

	 	
                  Trova cliente...
	
                  Avvia la procedura di ricerca di un cliente.

	 	
                  Nuova fattura...
	
                  Avvia la scheda per la creazione di una nuova fattura.

	 	
                  Trova fattura...
	
                  Avvia la procedura di ricerca di una fattura.

	 	
                  Nuovo lavoro...
	
                  Avvia la scheda per la creazione di un nuovo lavoro.

	 	
                  Trova lavoro...
	
                  Avvia la procedura di ricerca di un lavoro.

	 	
                  Procedura di pagamento...
	
                  Avvia l’assistente per la procedura di pagamento. È necessario aver selezionato un conto del tipo debiti correnti per proseguire.

	Venditore → 
	
                  Seleziona le operazioni relative al venditore.

	 	
                  Nuovo venditore...
	
                  Avvia la scheda per la creazione di un nuovo venditore.

	 	
                  Trova venditore...
	
                  Avvia la procedura di ricerca di un venditore.

	 	
                  Nuova ricevuta...
	
                  Avvia la scheda per la creazione di una nuova ricevuta.

	 	
                  Trova ricevuta...
	
                  Avvia la procedura di ricerca di una ricevuta.

	 	
                  Nuovo lavoro...
	
                  Avvia la scheda per la creazione di un nuovo lavoro.

	 	
                  Trova lavoro...
	
                  Avvia la procedura di ricerca di un lavoro.

	 	
                  Procedura di pagamento...
	
                  Avvia l’assistente per la procedura di pagamento. È necessario aver selezionato un conto del tipo debiti correnti per proseguire.

	Dipendente → 
	
                  Seleziona le operazioni relative al dipendente.

	 	
                  Nuovo dipendente...
	
                  Avvia la scheda per la creazione di un nuovo dipendente.

	 	
                  Trova dipendente...
	
                  Avvia la procedura di ricerca di un dipendente.

	 	
                  Nuova nota spese...
	
                  Avvia la scheda per la creazione di una nuova nota spese.

	 	
                  Trova nota spese...
	
                  Avvia la procedura di ricerca di una nota spese.

	 	
                  Procedura di pagamento...
	
                  Avvia l’assistente per la procedura di pagamento. È necessario aver selezionato un conto del tipo debiti correnti per proseguire.

	Tabella imposte di vendita
	
                 Visualizza e permette di modificare la lista di tabelle delle imposte.

	Editor termini di pagamento
	
                 Visualizza e permette di modificare la lista dei termini di pagamento.

	Promemoria scadenze ricevute
	
                 Visualizza e permette di modificare la lista dei promemoria delle scadenze per le ricevute.






Struttura dei conti - Menu Resoconti



Questa rappresenta solamente una breve lista di ogni resoconto o grafico disponibile. Ognuno di essi può essere personalizzato attraverso il pulsante Opzioni della barra degli strumenti e il foglio di stile utilizzato.
Tabella 4.6. Struttura dei conti - Menu Resoconti - Permette la scelta dei resoconti e dei grafici forniti da GnuCash.
	Voce del menu
	
                  Descrizione

	Attività e passività → 
	
                  

	 	
                  Portafoglio avanzato
	
                  

	 	
                  Istogramma delle attività
	
                  

	 	
                  Grafico a torta delle attività
	
                  

	 	
                  Saldo medio
	
                  

	 	
                  Stato patrimoniale
	
                  

	 	
                  Stato patrimoniale usando eguile-gnc
	
                  

	 	
                  Giornale generale
	
                  

	 	
                  Libro mastro generale
	

                
	 	
                  Portafoglio degli investimenti
	
                  

	 	
                  Istogramma delle passività
	
                  

	 	
                  Grafico a torta delle passività
	
                  

	 	
                  Istogramma del patrimonio netto
	
                  

	 	
                  Grafico a dispersione del prezzo
	
                  

	Resoconti per gli affari → 
	
                  

	 	
                  Resoconto venditori
	
                  

	 	
                  Fattura semplice
	
                  

	 	
                  Resoconto dipendenti
	
                  

	 	
                  Fattura elaborata
	
                  

	 	
                  Resoconto di lavoro
	
                  

	 	
                  Payable Aging
	
                  

	 	
                  Fattura stampabile
	
                  

	 	
                  Receivable Aging
	
                  

	 	
                  Resoconto tasse
	
                  

	 	
                  Resoconto clienti
	
                  

	Entrate e Uscite → 
	
                  

	 	
                  Flusso di liquidi
	
                  

	 	
                  Prospetto dei capitali
	
                  

	 	
                  Istogramma delle uscite
	
                  

	 	
                  Grafico a torta delle uscite
	
                  

	 	
                  Uscite per giorno della settimana
	
                  

	 	
                  Grafico delle entrate e delle uscite
	
                  

	 	
                  Istogramma delle entrate
	
                  

	 	
                  Grafico a torta delle entrate
	
                  

	 	
                  Prospetto delle entrate
	
                  

	 	
                  Entrate per giorno della settimana
	
                  

	 	
                  Bilancio di previsione
	
                  

	 	
                  Profitti e perdite
	
                  

	
                  Esempi e personalizzazioni → 
	
                  

	 	
                  Resoconto di benvenuto di esempio
	
                  

	 	
                  Resoconto multicolonna personalizzato
	
                  

	 	
                  Semplice resoconto con esempi
	
                  

	
                  Sommario del conto
	
                  Questo resoconto mostra il saldo del conto selezionato.

	
                  Resoconti personalizzati
	
                  Apre la finestra per la gestione dei resoconti creati dall’utente.

	
                  Resoconto tasse ed esportazione TXF
	
                  Crea un resoconto per le tasse (US) e/o esporta i dati per un software di elaborazione delle tasse (TXF).

	
                  Resoconto delle transazioni
	
                  






Struttura dei conti - Menu Strumenti



Tabella 4.7. Struttura dei conti - Menu Strumenti - Permette l’accesso a diversi strumenti e editor
	Voce del menu
	Descrizione

	Impostazione dell’Online Banking...
	
                  Avvia la procedura guidata per la configurazione dell’Online Banking se GnuCash è stato compilato con il supporto per l’online banking. la sezione chiamata «Procedura guidata per l’HBCI (Online Banking)»

                
	Editor prezzi
	Strumento per la modifica o l’immissione dei prezzi di titoli e fondi. Maggiori dettagli nella la sezione chiamata «Editor prezzi»

	Editor titoli
	Strumento per la modifica o l’immissione di azioni e commodity. Ulteriori dettagli nella la sezione chiamata «Editor titoli»

	Calcolatrice finanziaria
	Ulteriori dettagli nella la sezione chiamata «Calcolatrice finanziaria»

	Chiudi libro
	Apre una schermata in cui è possibile inserire le informazioni necessarie alla chiusura del libro contabile corrente.

	Libro mastro generale
	Vedere la la sezione chiamata «Libro mastro generale»






Struttura dei conti - Menu Finestre



Tabella 4.8. Struttura dei conti - Menu Finestre
	Voce del menu
	Descrizione

	Nuova finestra
	Apre una nuova finestra vuota di GnuCash.

	Apri la pagina in una nuova finestra
	Sposta la scheda corrente in una nuova finestra.






Struttura dei conti - Menu Aiuto



Tabella 4.9. Struttura dei conti - Menu Aiuto - Permette l’accesso a questo documento e alla guida ai concetti e manuale.
	Voce del menu
	Descrizione

	Guida ai concetti e manuale
	Spiegazione dei principi di contabilità e di come applicarli in GnuCash

	Suggerimento del giorno
	Mostra delle brevi note relative a funzioni che potrebbero non essere conosciute.

	Sommario
	Apre questo documento.

	Informazioni
	Mostra la schermata delle informazioni contenente la versione, la licenza e i ringraziamenti di GnuCash.








Struttura dei conti - Pulsanti e icone della barra degli strumenti




La finestra principale di GnuCash mette a disposizione una serie di pulsanti e icone utili per accedere facilmente alle funzioni più comunemente utilizzate nella scheda attiva. La barra degli strumenti può essere facilmente nascosta o visualizzata selezionando la voce Visualizza → Barra degli strumenti. Le opzioni visualizzate nella barra variano a seconda delle operazioni disponibili nella scheda attiva.
Una breve descrizione della funzione di pulsante della barra degli strumenti viene visualizzata quando il puntatore del mouse viene mantenuto al di sopra di esso per qualche secondo.
Tabella 4.10. Barra degli strumenti - Finestra dell struttura dei conti
	Pulsanti della Barra degli strumenti
	Descrizione

	
                  Salva (Ctrl+S)
                
	Esegue il salvataggio del file dei dati, inserendo tutte le transazioni nel file.

	
                  Chiudi (Ctrl+W)
                
	Chiude la pagina dei conti attualmente visualizzata

              Nota
Questa icona non è disponibile se è aperta una sola scheda; è disponibile per quelle successive che vengono aperte.


              
	Apri
	Apre il registro delle transazioni per il conto selezionato.

	Modifica
	Permette di variare le caratteristiche del conto selezionato. la sezione chiamata «Modificare un conto»

	Nuovo
	Avvia la procedura per la creazione di un nuovo conto. la sezione chiamata «Creare un nuovo conto».

	Cancella
	Rimuove il conto selezionato. la sezione chiamata «Cancellare un conto»






Barra delle schede



La barra delle schede visualizza in stile «fascicolatore» le schede per i registri delle transazioni, per i resoconti e per la struttura dei conti aperti.

Riquadro principale - Struttura dei conti



La schermata della struttura dei conti visualizza la struttura dei conti in ordine gerarchico. Questo permette l’organizzazione dei conti in base alla tipologia.
Suggerimento
Il triangolo (o il segno "+") a fianco del nome del conto, è utilizzato per aprire o chiudere la struttura dei conti. Quando si preme su di esso, l’orientamento della punta cambia da rivolta verso destra a rivolta verso il basso (diventa un segno "-"), per indicare che la struttura ad albero è aperta. Più a destra rispetto al nome del conto principale, saranno visibili uno o più sottoconti che potranno a loro volta avere, a fianco del loro nome, un altro simbolo triangolare (segno "+"); questo indica la presenza di un altro livello di sottoconti.

Nel riquadro principale sono mostrate, di default, quattro colonne: Nome del conto, Tipo, Descrizione e Totale. Per ogni conto, queste informazioni, se disponibili, sono 
Suggerimento
Le colonne visualizzate nella struttura dei conti possono essere personalizzate. Fare clic sull’icona all’estrema destra del riquadro della struttura dei conti per visualizzare una lista a comparsa delle colonne attivabili. Fare clic sul nome della colonna per aggiungerla alla finestra. Fare clic di nuovo sul nome per nasconderla.

Lo stile di visualizzazione predefinito per la finestra della struttura dei conti, è quello a "fascicolatore". Questo è indicato dalla presenza di una scheda nella riga delle schede della finestra principale. Altre schede appariranno a fianco di questa allorché vengano aperti anche dei resoconti, dei registri del conto o altre strutture dei conti.

Barra di riepilogo



La barra di riepilogo visualizza dei saldi relativi al tipo di conto aperto. Normalmente i conti visualizzano il saldo attuale, qualsiasi saldo futuro, un saldo per le operazioni liquidate e un saldo di riconciliazione. I conti per le azioni, comunque, visualizzano le quote totali e il loro valore. La barra di riepilogo può essere nascosta o visualizzata selezionando la voce Visualizza → Barra di riepilogo dal menu.

Barra di stato



La barra di stato visualizza dei suggerimenti che forniscono maggiori dettagli sulla voce del menu selezionata e mostra anche una barra di avanzamento quando si sta aprendo o salvando un file o generando un resoconto. La barra di stato può essere nascosta o resa visibile selezionando la voce Barra di stato presente nel menu Visualizza.
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